GIS Applications at Florida's Transit Agencies: Scope, Trends, and Issues

CUTR
NCTR - 473 - 02, BC137-39

2. Government Accession No. 

3. Recipient's Catalog No. 

4. Title and Subtitle  
GIS Applications at Florida’s Transit Agencies: Scope, Trends and Issues

5. Report Date  
May, 2003

6. Performing Organization Code  

7. Author(s)  
Martin Catalá


9. Performing Organization Name and Address  
The Florida Department of Transportation Statewide GIS for Transit Technical Assistance Program

10. Work Unit No. 

11. Contract or Grant No.  
DTRS98-G-0032

12. Sponsoring Agency Name and Address  
Office of Research and Special Programs (RSPA)  
U.S. Department of Transportation, Washington, D.C. 20590

Florida Department of Transportation  
605 Suwannee Street, MS 26, Tallahassee, FL 32399

13. Type of Report and Period Covered  


15. Supplementary Notes  
Supported by a Grant from the USDOT Research and Special Programs Administration, and the Florida Department of Transportation, FDOT Project Manager, Ike Ubaka.

16. Abstract  
This study reviewed the extent of GIS usage at Florida's transit agencies. A survey of these agencies was conducted to identify the trends and conditions of their GIS. In order to establish GIS benefits and trends, and to make recommendations for future GIS implementation, a comparison to a similar 1995 study was performed.

17. Key Words  
Public transit, GIS implementation, GIS resources.

18. Distribution Statement  
Available to the public through the National Technical Information Service (NTIS), 5285 Port Royal Road, Springfield, VA 22161, (703) 487-4650, http://www.ntis.gov/, and through the NCTR web site at http://www.nctr.usf.edu/.

19. Security Classif. (of this report)  
Unclassified

20. Security Classif. (of this page)  
Unclassified

21. No. of pages  
72

22. Price  

---

**Abstract**

This study reviewed the extent of GIS usage at Florida's transit agencies. A survey of these agencies was conducted to identify the trends and conditions of their GIS. In order to establish GIS benefits and trends, and to make recommendations for future GIS implementation, a comparison to a similar 1995 study was performed.
GIS Applications at Florida Transit Agencies:
Scope, Trends and Issues

A Report on the Florida Department of Transportation
Statewide GIS Transit Technical Assistance Program

Prepared by

Martin Catalá, Principal Investigator
Jason Alber, Graduate Research Assistant
Kristine Bezdecny, Graduate Research Assistant
Jennifer Flynn, Graduate Research Assistant

Center for Urban Transportation Research
University of South Florida
4202 East Fowler Ave CUT 100
Tampa, Florida 33620
813-974-3120

Prepared for

National Center for Transit Research (NCTR)
Center for Urban Transportation Research (CUTR),
University of South Florida for

Ike Ubaka, AICP
Program Manager, Transit Systems Planning
Florida Department of Transportation
605 Suwanee Street, MS 26
Tallahassee, FL 32399
(850) 414-4532; SunCom 994-4532; Fax (850) 922-4942

The opinions, findings and conclusions expressed in this publication are those of the authors and not necessarily those of the Florida Department of Transportation or the U.S. Department of Transportation.

This document was prepared in cooperation with the State of Florida Department of Transportation and the U.S. Department of Transportation.
# Table of Contents

Section 1: Introduction ........................................................................................................ 9  
Section 2: Background Information on GIS ................................................................. 11  
  GIS Benefits and Issues ................................................................................................. 11  
  Use of GIS in Transit .................................................................................................... 13  
  Factors that can Affect the Implementation of a Transit GIS ........................................ 14  
Section 3: State of GIS at Florida Transit Agencies ......................................................... 17  
  Survey Methodology ..................................................................................................... 17  
  Response Rate ................................................................................................................ 17  
  Survey Results ............................................................................................................... 18  
  Level of GIS Usage ........................................................................................................ 18  
  Operational Conditions ................................................................................................. 32  
  Implementation and management concerns .................................................................. 35  
  Benefits of GIS Implementation ................................................................................... 37  
  Summary of Survey Findings and trends in Florida transit GIS ................................... 37  
Section 4: Bus route and stop Data collection and updates ................................................. 43  
  GIS at Florida’s Transit Agencies ................................................................................. 43  
  Standardize Data Layers ............................................................................................... 50  
Section 5: GIS Technical Support and Listserv ............................................................... 53  
  Technical Assistance Program ....................................................................................... 53  
Section 6: Conclusions and Recommendations .................................................................. 61  
Appendix A: Census 2000 Variable .................................................................................. 67  
Appendix B: Survey Instrument ....................................................................................... 69  
Appendix C: Directions for Installing and Operating ArcReader .................................... 75
List of Tables

Table 1: GIS Data Maintained by Florida's Transit Agencies ...............................29
Table 2: Existing Transit GIS Data at Florida’s Transit Agencies .......................48
Table 3: Census Data Tables ............................................................................54
Table 4: Geodatabase Structure ......................................................................55
Table 5: Map Series .........................................................................................56
List of Figures

Figure 1: GIS Utilization .................................................................18
Figure 2: GIS Applications in 2002 ...............................................19
Figure 3: Areas of Use .................................................................25
Figure 4: Number of Applications Utilized .................................33
Figure 5: GIS Software Applications Utilized .........................34
Figure 6: Comparison of GIS Data Storage 1995-2002 by Data Type 37
Figure 7: Comparison of GIS Data Storage 1995-2002 by Agency 38
SECTION 1: INTRODUCTION

As part of its effort to improve transit planning and operations through innovation and technology applications, the Florida Department of Transportation (FDOT) contracted with the Center for Urban Transportation Research (CUTR) at the University of South Florida to assess the scope, issues and trends in GIS application by Florida transit systems. A major objective of this study was to update a 1995 report prepared by CUTR for FDOT on the use of GIS by Florida transit agencies. Other objectives of the study were:

- to collect information from transit agencies on the status of their bus stop/station inventories for the purpose of updating the Florida Transit Information System (FTIS),
- to provide short term technical support to the transit agencies, and
- to establish a Transit GIS Listserv for the dissemination and sharing of transit GIS information.

These objectives guided the development of the following project tasks:

- Survey Florida’s transit agencies
  - Conduct a GIS survey of Florida’s transit agencies utilizing a web-based survey instrument adapted from the 1995 survey.
  - Establish trends and conditions of GIS activities at Florida’s transit agencies by comparing the survey results with the 1995 study results.

- Collect and deliver bus route and stop information for the Florida Transit Information System (FTIS)
  - Gather bus route and stop information from each transit property with available data; conduct all required data manipulations for integration into the FTIS system.

- Create Transit GIS Listserv
  - Create and manage a Transit GIS listserv for all transportation professionals.
Provide Short-term Technical Support

- Provide technical assistance to transit agencies seeking assistance. The assistance will be limited to one-time short-term assistance, regarding GIS manipulation, techniques, and data design.

- Distribute GIS data and software applications to assist agencies with little or no GIS activities.

Present findings and report on the state of GIS at Florida’s Transit agencies at the mid-year Florida Public Transit Association workshop meeting.

This report presents the findings and results of the above tasks, including analysis and recommendations on critical issues facing transit agencies in the implementation of GIS. Although the focus of this report is on Florida transit systems, other transit agencies around the country interested in GIS may also benefit from its findings.

Following this introduction, the remainder of the report is organized into the following six sections:

- Section 2 provides general background information on GIS, including issues and benefits;
- Section 3 describes the state of GIS at Florida transit agencies based on findings from the GIS survey;
- Section 4 describes the results of route and stop data collection from transit agencies;
- Section 5 describes the creation of a GIS listserv and the technical assistance provided to transit agencies;
- Section 6 provides conclusions and recommendations on transit GIS.
SECTION 2: BACKGROUND INFORMATION ON GIS

GIS BENEFITS AND ISSUES

Geographic information systems (GIS) integrate data and spatial information to allow for advanced analysis as well as database maintenance. GIS information is stored in layers of information that identify trends and patterns not recognizable from tabular data. By adding a geo-spatial element to data, users are able to recognize patterns in the data such as proximity and clustering and adjacency of data units. More advanced uses of the geo-spatial data would include calculating proportional area values, such as the service area of a route. By capturing the most fundamental parts of a transit system in a GIS, such as the routes and stops, an agency can establish the foundation for a robust GIS. This foundation allows the transit agency to automate many of its reporting requirements. Some examples include the route directional miles, one-quarter mile and three-quarter mile service area calculations, ridership by stop and route, bus stop amenities, the level of Title VI and ADA compliance.

GIS software has advanced significantly, and nearly all GIS desktop software platforms offer the same basic functions. There is a wide range of prices and functionality for desktop GIS, with prices ranging from $500 to $10,000. Agencies looking to begin implementing GIS at their agency can do so for under $2,000. A typical GIS has general map production capabilities, with printing and map exporting functions and thematic mapping, (i.e., mapping data ranges for census demographics, or ridership levels or identifying amenities of a bus stop inventory). All GIS platforms can import and read many data types; so data currently stored in MS Access, MS Excel, Lotus, Paradox, and dBase can easily be integrated with GIS. Additionally, the GIS can export the data into other software platforms for integration into reports or presentations. A transit agency considering a GIS should ensure that the GIS it purchases can easily read or import the file type in which its data is currently stored.

While there is great similarity among the many GIS platforms available, transit agencies implementing a GIS should consider what other area agencies and municipalities are using. Since much of the beginning efforts of implementing a GIS is establishing the base data, capitalizing on data already created by other agencies is key to a quick start-up. Consequently, to ensure a quick start-up, a transit agency may want to consider a GIS platform that is compatible with GIS platforms of the other area agencies, MPO, regional planning council and property appraisers.

In spite of all the advances and similarities among GIS software, several differences should be considered. Each GIS platform utilizes its own native file format, and the differences between each type should be taken into account in an agency’s decision. Certain GIS file types have advantages over others when it comes to transportation
GIS. The GIS should easily utilize topology, an important feature for transportation GIS. Topology is the expression of the relationship between and within spatial data. For example, while a GIS expresses the location of a feature, such as a road, topology expresses the connection the road has to the overall road network. Topology illustrates the adjacency and connectivity of GIS features. Some file formats have built in topology, while others require effort to create the topology. Topology becomes important when attempting to conduct modeling functions, such as shortest path calculations. With a complicated system to implement topology, distance calculations and trip planning can become quite cumbersome. It is important for the software to have a file format that easily supports topological features.

Software integration is another concern transit agencies should consider in their purchase of a GIS platform. The GIS software platform should easily integrate with scheduling and AVL systems, as well as database, spreadsheet, and word processing software currently utilized at the agency. The agency should research which file formats communicate easily with the desired AVL, automatic passenger counter (APC) and scheduling software applications. By ensuring that a selected GIS application easily integrates with the transit applications used, the implementation of GIS will be less complicated, allowing for quick deployment and opportunity to expand the use of the GIS.

Perhaps the single largest constraint to implementing GIS at an organization is training and skill level. Many transit planners have limited or no experience using GIS and will need significant training at the beginning. Any software application being considered should provide significant training opportunities, and a relatively nearby training schedule and a list of vendors offering software training for the product being purchased should be available. With more training opportunities within the area, the agency can reduce its travel related training costs.

Many GIS software companies offer a suite of products, with a tiered system for different degrees of functionality. Agencies should consider the expansion abilities of the software for future uses. Additionally, many businesses form partnerships with GIS companies to make “add-ons” to increase functionality and simplify tasks. Larger GIS companies have more partners, which may weigh in a transit agency’s choice of GIS platforms. A short list of GIS software platforms will help point a transit agency in the right direction.

GIS provides transit agencies, small and large, with an opportunity to automate the collection and analysis of performance data. The technology provides a foundation for the agency to perform many daily activities as well as meet and automate many state and federal reporting requirements. A survey of all of the agencies will indicate the level of GIS usage and identify opportunities where GIS resources can be utilized.
The significant differences among Florida’s transit agencies indicate that the GIS needs for each of the agencies are considerably different. Consequently, an examination of the different levels of GIS activity at Florida’s transit agencies is necessary.

**USE OF GIS IN TRANSIT**

The study conducted in 1995 by CUTR examined the use of GIS at public transportation agencies in Florida. The study indicated that only one-third of Florida’s transit agencies were using GIS at this time. The study categorized the uses of GIS into four groups:

- Information dissemination
- Transit planning
- Facilities and real estate management
- Operations and control

Grouping the information into these four categories, the project was better able to assess GIS usage. To better understand the changes in GIS utilization at Florida’s transit agencies, this same methodology was used in the current study.

**Information Dissemination**

This category refers to GIS activity designed to communicate data and geo-spatial information to management, board members, and the public. Products like system maps, individual route maps, and web-based route information are a few examples of how GIS can be used to disseminate information about the characteristics of a transit agency. Additionally, the results of analysis, such as service area characteristics, demographic distribution of specific populations, and proposed transit service alternatives, can be easily communicated with a GIS.

**Transit Planning**

Perhaps the most significant potential use of GIS for agencies is in the area of transit planning. GIS provides many tools that enhance the abilities of the transit planner. Service planning, ridership forecasts, accessibility analysis, and market analysis are examples for using GIS in transit planning.
Facilities and Real Estate Management

One of the most common activities of GIS in transit is related to maintenance and management of facilities and real estate. All the facilities of the transit agency can be geographically referenced with a GIS. The GIS stores the location information as well as descriptive characteristics of the facilities. Park and ride lots, transit stations, maintenance facilities, and bus stop locations and characteristics are a few examples of using GIS in this manner. The extent and breadth of information for these data sets can be extensive. For example, a bus stop inventory can contain much information such as shelter availability, handicap accessibility, location information such as cross streets, performance information such as daily ridership, and routes that serve the stop. Other information such as revenue from marketing signs at stops and on buses can be stored in the database; the GIS provides for ease of access and analysis.

Operations and Control

GIS can play an important function in the operation and control of transit service. The data stored in the GIS can be used to improve the customer service by enhancing the customer information services. These activities can be used to help with fixed route as well as paratransit services. The GIS provides a unique utility to access the data in both visual and tabular formats.

More advanced activities include AVL systems with GIS, allowing real-time display of bus activity. This technology can be used to provide information to the customer information service staff and can be displayed with web-based solutions as well. Coupled with automatic passenger counters the AVL technology can communicate the location and speed of a transit vehicle as well as the current ridership on each bus.

Similar technologies are used for scheduling and dispatching of paratransit vehicles. Routing and geocoding services with GIS technologies is another example of how GIS is used in the operations and control of a transit agency.

Factors that can Affect the Implementation of a Transit GIS

Many factors can affect the implementation of GIS at a transit agency. The 1995 study identified several factors that influence the implementation of GIS at transit agencies. These factors ranged from organizational structure to staffing and management issues and software selection. Today, these factors are still important as they pertain to the implementation of GIS.
Different Characteristics of Transit Agencies

Differences in the scope and application of GIS among Florida transit agencies are partly due to the wide variability in the size and scope of these agencies. Florida’s 27 urban transit systems range in size from small community-based systems with less than 10 buses to large metropolitan transportation systems with more than 500 buses supporting commuter and light rail systems. Service area characteristics for these agencies vary widely as well, with population densities ranging from a little more than 350 people per square mile to over 3,900 people per square mile. Overall, the transit systems have a service area of over 11 million square miles and provide nearly 192 million passenger trips annually. Again, the difference among the agencies is vast, with the smallest agency having 3,609 annual passenger trips and the largest having over 84 million annual passenger trips.

Institutional Support

The institutional support afforded GIS within an agency can influence its development and utilization. Often, the level of institutional supported is related to the organizational structure. A variety of organizational structures exist among Florida’s transit agencies. Many transit agencies are part of a larger organization such as a City or County government or an MPO. Other agencies stand alone as independent authorities. Each organizational design provides different opportunities, but it also impacts how GIS is used within the organization. Transit agencies that are part of a larger unit have the advantage of dedicated GIS staff to address the GIS needs of the organization. These organizations can take advantage of a full-time GIS professional without the financial and management responsibilities. This will allow the agency to capitalize on the benefits of GIS, by automating data collection and analysis of a transit systems features. The GIS can simplify the reporting process and allow transit agencies to focus on identifying areas of need and improving service.

Management Support

Like any technological resource, management support and cooperation are essential for successful implementation. Without the resources and commitment of decision makers in the organization, implementing GIS becomes very difficult. Committing resources to invest in GIS is also essential to success and includes training, hardware, data and software.

Staff Resources

The different sizes of transit agencies affect how they manage their workforce. Large agencies with many employees are able to have specialized employees that work in one particular field. Small agencies, on the other hand, tend to have more general-purpose employees who perform a variety of functions. This affects the
implementation of advanced technologies such as GIS. A large agency is able to have a dedicated GIS staff to plan and implement GIS, while a smaller agency may have one person who is familiar with GIS and has additional responsibilities. The presence of qualified GIS staff can significantly impact the successful implementation of a GIS. Conversely, untrained staff can stall implementation efforts, with frequent failures. It is important to note that stalled implementation efforts can create an organizational culture that may not support GIS activities. Under these conditions, GIS may be seen as too costly, ineffectual and a poor return on investment. Investing in training and/or a GIS professional can ensure successful implementation of GIS. A good foundation of any GIS department is a qualified staff.

**Long-Term Planning**

GIS implementation is a long-term commitment and should be planned accordingly. Creating a GIS implementation plan can create an environment where needs of different departments are met and considered when the investment necessary for implementing a GIS is needed. Implementation strategies should have a staged approach, looking at the most critical GIS needs and identifying different implementation stages. Long-term planning ensures that the GIS technology will continue to adapt to the changing needs of the organization as well as contribute to its successful implementation.

**Resources for Planning**

Adequate resources for an implementation strategy must be designated and considered. An implementation strategy must consider all the necessary resources, including hardware, data, software and personnel. Establishing real costs of implementation can help management realize the true costs of implementation. An implementation strategy should include the cost of hardware, software, data, and personnel. Establishing realistic costs will create an environment beneficial to implementation.

**Selection of GIS Platform**

As part of the implementation strategy, transit agencies should properly investigate which GIS platform best suits its needs. Expertise in the GIS field may be needed to best determine which GIS application is best suited for any given agency. For this reason, outside assistance is needed. However, it is important to identify software applications that provide support and to have on-site and local training opportunities. Additionally, agencies should investigate which GIS platforms are being used by area transportation agencies such as the MPO. Using the same GIS platform can contribute to the implementation of a GIS by capitalizing on data sets already created by other agencies.
SECTION 3: STATE OF GIS AT FLORIDA TRANSIT AGENCIES

To establish the extent and level of GIS activity at Florida’s transit agencies a survey of the agencies was used to collect information regarding the use of GIS, similar to the CUTR study conducted in 1995.

SURVEY METHODOLOGY

Using the same survey created for the 1995 CUTR study, CUTR created a web version of the survey to assist with automating the data collection efforts. The 1995 survey was modified slightly because only transit agencies were being surveyed for this project. There were three steps to implementing the survey:

(1) Converting Survey into web-based instrument

To facilitate the collection of the data via a web-based survey, the survey was converted into a web form. This process involved using an online form which allows for the results of each survey to be compiled into a comma-delimited file for easy importing into a spreadsheet.

(2) Administering the survey

The GIS contact information was collected and organized into a data base and the information was used to distribute e-mail invitations to participate in the survey. In January 2002, the on-line surveys were e-mailed to 27 transit agencies. Respondents were asked to complete the survey on-line and submit the entries via the web. Agencies with limited or no web access were sent a printed version of the survey with instructions to return them by fax.

(3) Follow up

Follow-up on surveys not completed or with unclear information were made for clarification. E-mail and phone calls were made to survey respondents to clarify other questions and to remind them to fill out the survey.

RESPONSE RATE

Of the 27 transit agencies surveyed, 22 responded (81%). The responses of the West Florida Regional Planning Council, which performs the planning and GIS activities for Okaloosa County Transit and Bay County Transit, were considered as two separate responses. One agency filled out the printable version of the survey and faxed back the results. The data were transferred into a spreadsheet with the other on-
line responses. The responses of two agencies were collected via phone interview. The survey responses of two transit agencies were reviewed because two separate responses were submitted. Follow-up phone calls were made to clarify any discrepancies among the responses and the survey results were combined.

**Survey Results**

To be consistent with the 1995 survey, the survey instrument was designed to obtain information in the following three areas:

- Level of GIS usage
- Operational conditions
- Implementation and management concerns

Summarizing the results of the survey into each of the above-mentioned categories clearly illustrates the state of GIS at Florida’s transit agencies.

**Level of GIS Usage**

Florida’s transit agencies employ technologies such as GIS for varied reasons. Ridership forecasting, service planning, market analysis, asset management, customer service, and map-making are but a few. Many of Florida’s transit agencies utilize GIS software in some manner. However, the extent of the usage varies widely; with some integrating GIS into many of its operations and others using it sparingly. To establish the level of usage, the survey examined three areas:

- Utilization
- Areas of Use
- GIS Data Use

Respondents were asked to indicate the extent of use, areas of use and types and sources of data being used.

**GIS Utilization**

Of the 22 survey respondents, 16 indicated having GIS capabilities within their organization (72%). This is a significant increase from 1995, where 33 percent of the respondents indicated using GIS. Among the 6 agencies that did not use GIS within their organization three indicated plans to implement GIS in the future. Figure 1 illustrates the GIS utilization among Florida’s transit agencies in 1995 and 2002.
The increasing utilization of GIS technology at Florida’s agencies is a significant occurrence. Further examination of the agencies not utilizing GIS technologies and not planning to use GIS in its future revealed that these agencies were mostly newly established transit agencies.

**Areas of Use**

The survey asked respondents to indicate specific areas of GIS usage to better determine the extent of GIS activity within the organization. The responses for this section were categorized into four groups. The 1995 study did not delineate the survey information for transit properties only. Consequently, a comparison of the responses for this question was not possible. However, a detailed description of activities in the following areas was obtained from the survey:

- Information dissemination
- Transit planning
- Facilities and real estate management
- Operations and control

For all the transit agencies that responded to the survey, the most common area of usage for GIS is information dissemination. This category includes several areas of use, including map products, operator maps, system maps, route schedules and maps,
web information and telephone based customer service. Facilities and real estate management, and transit planning were the second most common GIS usage and the least was operations and control. Figure 2 shows the distribution of the areas of GIS applications in 2002.

**Figure 2**

GIS Applications at Florida Transit Agencies 2002

<table>
<thead>
<tr>
<th>Area</th>
<th>Responses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facilities Management</td>
<td>18</td>
</tr>
<tr>
<td>Operations and Control</td>
<td>15</td>
</tr>
<tr>
<td>Transit Planning</td>
<td>18</td>
</tr>
<tr>
<td>Information Dissemination</td>
<td>27</td>
</tr>
</tbody>
</table>

**INFORMATION DISSEMINATION**

GIS provides a unique medium for communicating much information, including trends, data, and spatial patterns of data. Transit agencies are able to communicate a new proposed routing configuration and full network design with a GIS. Additionally, GIS allows these data to be easily shared with other departments as well as with the public in hearings and on the internet via the world wide web. Generally, within a transit agency there are two types of communications, internal and external. GIS data and maps can facilitate these forms of communications. The following areas cover the types of information dissemination with its internal and external clients.

*Map Products (8 positive responses)*

Map products are the most commonly recognized GIS application. The printed map easily communicates transit related information to the user. Eight of the agencies indicated using GIS to make map products. Planners can use these products
internally for planning purposes and externally at public hearings to communicate with the public. All GIS applications have map printing functions, and this response rate is most likely an under-representation of the use of GIS for this purpose.

**Web Applications (3 positive responses)**

Web applications allow non-GIS users to have access to GIS data and maps. Web application can include posting GIS maps on the web site, Internet map servers, and on-line trip planning. The web applications can be used for internal and external use and provide access to many layers of GIS information, to transit planners and the public. Three of the transit agencies indicated utilizing web-based GIS applications. Two of the three indicated using the GIS web application to serve employees and the public.

**Operator Maps (1 positive response)**

Operator maps are a form of internal information dissemination. The GIS data provide bus operators with detailed information regarding the directions of a route. This requires accurate route data and regular updates of the information. Only one agency indicated using GIS with making operator maps.

**System Maps (6 positive responses)**

System maps are an external form of information dissemination communicating with the public and transit users to help navigate the transit system. System maps typically have higher graphic quality and while GIS can serve as a basis of this type of publication, it is not uncommon for GIS data to be imported into a graphics program for a graphics professional. Six transit agencies indicated using GIS for system maps.

**Route Schedules and Maps (5 positive responses)**

Much like the system maps, routes schedules and maps help with communications with the public. GIS software applications can create route schedules and maps without the use of a graphics professional. However, it is common for the schedules and maps to be made with a graphics program. The GIS still acts as a basis for the route schedule; however, the graphics program ensures a higher quality-publication. Five transit agencies indicated using GIS with its route schedules.

**Telephone Based Customer Service (2 positive responses)**

Two agencies indicated use of GIS with their customer service system. This is an ideal area for GIS, where much information about the system can be easily communicated through a map, and the customer service representative can have the GIS map information readily available to assist with service. However, using the GIS information in a format where non-GIS users can query and view the data without the investment of training the customer service employee on GIS is much more
advanced. Some customization of the GIS data would be necessary to accomplish this task.

Transit agencies using GIS as an everyday part of operations and planning are more advanced than agencies using it sparingly. An analysis of the types of activities illustrates the level of GIS usage.

**Facilities Management**

Facilities management is a strong element of a GIS application. The GIS is able to store descriptive information regarding a facility as well as illustrate its location and the characteristics of its location. For example, bus stop inventory stores information regarding its amenities, such as the presence of shelter, and is able to determine if a stop is located within a municipal boundary. By storing facility information in a GIS, a transit agency is better able to manage and access the information about the facilities, which can improve the management of those facilities.

*Park and Ride Lots (5 positive responses)*

Storing information regarding park and ride lots in a GIS allows the agency to identify potential customers of the lot. For example, an employee working in a central location and living in a given distance of a park and ride lot might be best to market new service to. Additionally, an inventory of park and ride lots stored in a GIS would allow planners to identify gaps in the location of park and ride lots. Five transit agencies indicated using a GIS to manage park and ride lots.

*Transit Stations (3 positive responses)*

Agencies using a GIS to manage the transit station facilities, can track many descriptive features of the facility. Ridership counts and the buses that serve the station are a few attributes that can be stored in the GIS. Headway frequency and other service characteristics can be stored with the transit stations. Additionally, safety issues can be tracked at the transit stations to better ascertain the safety issues at that transit station. Three agencies indicated using GIS to manage the transit station information.

*Fixed Facilities and Real Estate (6 positive responses)*

Storing facility information such as real estate owned by the property allows the agency to determine the revenue generated by a real estate property. Other fixed facilities such as transit centers, administrative offices, and bus stops are easily stored in a GIS. Six agencies indicated using GIS to manage the fixed facilities and real estate assets of the transit agency.

*Bus Stop Inventory (8 positive responses)*
The bus stop inventory provides the transit agency with a multitude of information about the transit system. It can store amenity information such as the presence of shelters or benches, or whether the stop is handicapped accessible. Additionally, the stop inventory can store ridership statistics, buses serving the stop, and land-use type. Since the bus stop inventory can store and manage this information so well, it provides the transit agency so many opportunities. For example, by storing bus stop inventory in a GIS, the agency is able to easily measure the number of sheltered stops located within a minority community, making the Title VI reporting requirements a much easier task. Four agencies indicated using a GIS to store bus stop inventories. However, 12 agencies indicated having an inventory. This inconsistency exists because agencies did not maintain and update the inventory, or it was collected by a third party and not regularly utilized.

**Transit Planning**

The ability of GIS applications to assist transit agencies to analyze and measure transit performance is significant. Measuring the service area, directional route miles, ridership, and establishing federal compliance to Title VI and ADA are prime examples of how GIS can be used to analyze a transit systems performance. Additionally, GIS can help with ridership forecasts and marketing efforts. The following areas detail the extent which agencies are using GIS with transit planning efforts.

*Service Planning (7 positive responses)*

The single largest response in this section was for service planning. Seven of the agencies indicated the use of GIS for service planning. Route designs and service area calculations are ideal examples of using GIS for service planning. Any worthwhile GIS application will be able to establish the service area of a route by measuring the ¼-mile buffer around the route and calculating the demographic characteristics of that buffer. FDOT considers the analysis so important it has created an application that performs this analysis. The Florida Transit Information System (FTIS) has a GIS component to it, which allows transit agencies to perform ¼ service area calculations. This software is available free from the transit office of FDOT.

*Market Analysis (3 positive responses)*

GIS applications strong spatial and database functionality make it an ideal application for market analysis. Using a GIS, an agency can determine the marketability of a route. A map of employees of an office park with a strategically-designed route can be an effective tool for marketing an express route to a particular office park. Additionally, the GIS allows the agency to market the advertising signs on the buses and at stops. Ridership numbers at stops and on buses can make a convincing argument for advertising with the transit agency. Three agencies indicated the use of GIS with market analysis.
Transit Ridership Forecasts (3 positive responses)
Techniques for forecasting transit ridership with a GIS require a wide range of skills. The type of forecasting also ranges from a complex transit model to a demographic profile of a community, identifying the high incidences of a particular population that might have a higher incidence of transit usage; for example, a community with a higher number of households with zero-vehicles. Three agencies indicated the use of GIS with transit ridership forecasting.

Title VI (3 positive responses)
Transit agencies have many reporting requirements from the state and federal level. One particular example is the Title VI reporting requirements. Every two years agencies must determine the level of services being provided to minority communities. Among the means of establishing the level of service are the total route miles and the bus stop amenities within the community. GIS is an ideal tool to quickly and accurately measure the extent and quality of transit service to a community. In maintaining an up-to-date bus stop inventory and route inventory, the GIS is able to calculate and measure the extent of services within a community. Three transit agencies indicated using GIS to help with the Title VI reporting requirements.

Americans with Disabilities Act (ADA) Compliance (4 positive responses)
Another requirement of the transit agency is to establish the level and extent of transit service that is accessible to the disabled population. A perfect example of this effort is the bus stop inventory. By collecting and establishing the extent of the bus stops that are accessible to the population of riders with disabilities, the transit agency is able to establish where the accessibility is lacking and establish an action plan to address the shortcoming. The GIS is an ideal tool for measuring and analyzing the extent to which an agency is complying with ADA standards. Four agencies indicated using GIS in this manner. Three of the four indicated using GIS for Title VI reporting as well.

Operations and Control
GIS applications have a wide range of uses within a transit agency. As agencies advance their use of GIS, the applications can become a part of the everyday business of the agency. When GIS is used in this manner, it helps with operations of the organizations and indicates a robust use of GIS applications. Agencies indicating the use of GIS in this manner are potentially more advanced GIS users.

Transit Scheduling and Run Cutting (3 positive responses)
Transit scheduling and run cutting are an important part of a transit agency’s daily operations. GIS applications must be customized to perform this task. However,
there are several scheduling and run cutting applications that can communicate with the GIS software. Three agencies indicated the use of transit scheduling and run cutting with GIS. The agencies responding to this question indicated using Trapeze software.

**Paratransit Scheduling and Dispatch (4 positive responses)**

Paratransit scheduling and dispatch are software used for paratransit service by the agency. Applications in this area are more GIS friendly and often can be add-ons to existing GIS applications or using GIS applications to help with the dispatch and scheduling tasks. There were four agencies utilizing GIS to meet paratransit scheduling and dispatch needs.

**Automatic Vehicle Location (AVL) (3 positive responses)**

Automatic vehicle location is a technology that integrates GIS technology and global positioning software (GPS) to track vehicle location. Many GIS applications have the ability to read and track GPS data to track the location of a transit vehicle in real time. This type of information can be very useful in the operation of the transit agency and assistance with customer information requests. For example, an agency using AVL technology in cooperation with its customer service system will be able to tell a customer the location of a bus and its expected time of arrival. Three agencies indicated utilizing AVL technologies. Two of the three agencies indicated using GIS with paratransit scheduling and dispatch.

**Ride Matching (3 positive responses)**

Ride matching is the process of identifying potential carpool, vanpool, or shuttle services for employees. GIS is ideal for addressing this process, combining the strengths of GIS, a solid database, and geospatial analysis. For example, a GIS can identify employees that work in one department and that live within one mile of a park and ride lot. Ride matching is often used to address transportation demand management (TDM) strategies but can be used effectively by transit agencies to help market a shuttle service to an office park. Three transit agencies indicated using GIS in this manner.

Figure 3 details the results of the survey.
Figure 3
Areas of GIS Application

GIS Data Usage

The amount and type of GIS data a transit agency utilizes is an indicator of the level of GIS usage. Greater utilization requires more GIS data. Among the 16 transit properties using GIS, all indicated storing and using GIS data created within its organization. In some cases, the agency indicated that some GIS data are stored and created by another department or agency. Data such as demographics, Traffic Analysis Zones (TAZ), political boundaries, and street files are maintained and created by an agency outside the transit department. The survey indicated that a separate GIS department that is responsible for creating and managing GIS data created the data.
Bus Routes (12 responses)

Of the transit-related data stored by the agency, the most prominent feature stored in a GIS is the bus route layer; it is perhaps the most fundamental element of a transit GIS system. Routing information begins to provide the foundation from which any transit system’s GIS can grow. It is the basis for calculating directional miles and service area calculations. Route level data can be used for creating system maps, route schedules, headway analysis, and service area analysis. One-third (33%) of the transit agencies in the 1995 study reported having bus route data stored in a GIS. In 2002, 44 percent of the agencies indicated storing bus route information.

Political Boundaries (12 responses)

Political boundary files store the extent and location of a municipality or City Council district, allowing an agency to measure the level of transit activity within a particular political boundary. For example, a County Commissioner may request the total number of route miles provided to his/her district. An agency using these data will be able to determine the level of transit activity provided to the district. The 1995 study indicated that 3 (17%) of the agencies stored this data in a GIS. In 2002, 12 (44%) of the agencies indicated storing political boundary information in a GIS.

Traffic Analysis Zones (10 positive responses)

Traffic analysis zones are data that are divided by geographic and land-use type delineations. Commonly, TAZ data are used for transportation models and most model outputs are read by a GIS application. The data from the TAZ can assist planners with service planning efforts. The transit agency may use this data provided by the local MPO to present route alternatives. In 1995, 3 (17%) of the agencies used TAZ data; in 2002, 10 (37%) of the agencies indicated using TAZ data.

Census Tract Boundaries (10 positive responses)

The U.S. Census Bureau creates the census tract boundaries and the descriptive attributes of the census tracts. The tract is a statistical subdivision of a county established by the Census Bureau. Data collected from the decennial census are stored in the census tract, and transit agencies can use the data for service planning. For example, the census can be used to measure the percent of households with income below the poverty level within a given census tract. Agencies can use the census tract boundary data to determine the service area characteristics of a transit network. In 1995, 4 (22%) of the agencies reported using Census tract data. In 2002, 10 (37%) of the agencies reported storing census tract boundary files.

Demographic Data (8 positive responses)

Demographic data includes data such as data provided by the U.S. Census. Other data regarding the socio-economic make up of a community are also available from private vendors and from models provided by public agencies. As Census data
becomes more out of date, these data sources become more useful. The 1995 study indicated that 28 percent of the transit agencies used demographic data. In 2002, 8 (36%) agencies reported using demographic data with its GIS.

**Bus Stops (7 positive responses)**

Bus stop data are perhaps the most complex of GIS data. They present many agencies with challenges regarding data collection and management of the data. A well-managed and designed bus stop inventory allows an agency to perform on-board surveys, establishing ridership totals by route and stop. Bus stop inventories are critical for determining Title VI and ADA compliance, and the data are used for recording and managing bus stop amenities such as a bench and shelter information. With a properly-designed and maintained bus stop inventory, agencies are able to calculate the distance between stops, evaluate stop amenities, and establish service characteristics at the stop level. A significant effort is necessary to continually keep the bus stop inventory up to date. Anecdotal information from follow-up phone calls indicated that many agencies collected the information but did not establish a system for updating and maintaining the inventory. The 1995 study reported 7 (39%) of all the agencies have a bus stop inventory in a GIS. In 2002, only 7 (32%) of the agencies had bus stop inventories in GIS.

**Transit Stations (5 positive responses)**

Agencies that would indicate the use of GIS to manage information for transit stations alone are probably storing a limited bus stop inventory, with transfer stations, large transit facilities, and high ridership stops included in the database. However, the 5 agencies indicating transit stations as being a dataset they store are agencies with a bus stop inventory. It could be concluded that the bus stop inventory differentiates between a regular stop and a transit station. The 1995 study indicated that 4 (22%) of the agencies stored transit stations with a GIS. In 2002, 5 (19%) reported storing transit stations in a GIS.

**Time Points (4 positive responses)**

Bus timepoints are much like transit stations. Alone, they would indicate a proxy for a bus stop inventory. However, each of the agencies that indicate using “bus time points” also have bus stop inventories. Most probably, these agencies are using the time points as an attribute of the stop or for other activities. Additionally, timepoints can be used with scheduling and routing software. Two of the agencies reported using scheduling software, Trapeze. There was no change in the number of agencies using GIS to store time point information; however, the percentage decreased since the 1995 study. In 1995, 22 percent of the agencies responded to storing time points, in 2002, the percentage decreased to 15 percent.
Park and Ride Lots (4 positive responses)
Storing information regarding park and ride lots in a GIS allows the agency to identify potential customers of the lot. For example, employees working in a central location that live within a given distance of a park and ride lot might be best to market new service to. Additionally, an inventory of park and ride lots stored in a GIS would allow planners to identify gaps in the location of park and ride lots. In 1995, 3 (17%) of the transit agencies stored park and ride data in a GIS. In 2002, 4 (18%) of the transit agencies indicated using a GIS to manage park and ride lots.

Rail Transit Routes (3 positive responses)
Rail transit routes are a rare set of data for Florida agencies to use simply because there is very little transit activity along rail lines. In 1995, 1 agency reported storing rail transit information; in 2002, 3 agencies reported storing the data.

Accident Locations (3 positive responses)
Reporting accident locations in a GIS allows the agency to identify the location and condition of the accident. The 1995 study indicated that 1 transit agency tracked transit accident locations in a GIS. In 2002, 3 agencies tracked accident location in the GIS.

Table 1 provides the details of the data used and stored by Florida’s transit agencies.
# Table 1
GIS Data Maintained by Florida's Transit Agencies

<table>
<thead>
<tr>
<th>Transit Agency</th>
<th>GIS Data</th>
<th>Rail Transit Routes</th>
<th>Bus Transit Routes</th>
<th>Political Boundaries</th>
<th>Rights of Way</th>
<th>Traffic Analysis Zones</th>
<th>Bus Stops</th>
<th>Census Tract Boundaries</th>
<th>Bus Timepoints</th>
<th>Demographic Data</th>
<th>AVL Signposts</th>
<th>Crash Locations</th>
<th>Traffic Signals</th>
<th>Incidents Req'ing Police</th>
<th>Transit Station</th>
<th>Park &amp; Ride lots</th>
<th>Other data sets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Broward County Transit</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collier County Transit</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Escambia County Transit</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hillsborough Area Regional Transit</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jacksonville Transportation</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key West Transit</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lakeland Area Transit District</td>
<td>NA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lee County Transit</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lynx (Central Florida R.T.A.)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manatee County Area Transit</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Martin County Transit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Miami Beach (ELECTROWAVE)</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Miami-Dade Transit</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Okaloosa County Transit**</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Palm Beach County Transit (PalmTran)</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Panama City Urbanized Area**</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 1 (continued)

<table>
<thead>
<tr>
<th>Transit Agency</th>
<th>GIS Data</th>
<th>Rail Transit Routes</th>
<th>Bus Transit Routes</th>
<th>Political Boundaries</th>
<th>Rights of Way</th>
<th>Traffic Analysis Zones</th>
<th>Bus Stops</th>
<th>Census Tract Boundaries</th>
<th>Bus Time-points</th>
<th>Demographic Data</th>
<th>AVL Signposts</th>
<th>Crash Locations</th>
<th>Traffic Signals</th>
<th>Incidents Req’ing Police</th>
<th>Transit Station</th>
<th>Park &amp; Ride lots</th>
<th>Other data sets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gainesville Regional Transit System*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sarasota County Area Transit (SCAT)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(X X)</td>
<td>(X X)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Space Coast Area Transit (Brevard County)</td>
<td>NA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SunTran (Ocala/Marion County Transit)</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Suwanee Valley Transit Authority</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TALTRAN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(X X)</td>
<td>(X X)</td>
<td></td>
<td>(X X)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(X X)</td>
</tr>
<tr>
<td>VOTRAN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(X X)</td>
<td>(X X)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(X X)</td>
</tr>
<tr>
<td>Pasco County Public Transportation</td>
<td>NA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indian River County Transit System</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Did not complete this section of the survey

** WFRPC serves as proxy planning and GIS for Escambia Okaloosa and Bay County
OPERATIONAL CONDITIONS

The impact of an organization’s administrative structure and the support for GIS services influences the manner and degree in which GIS is implemented. To establish the operational conditions at Florida’s transit agencies the following classifications were used:

- Departmental structure
- Training availability
- Cooperative ventures
- Software used

Each classification will illustrate the conditions which GIS operates under at Florida’s transit agencies.

Departmental Structure

A transit agency’s organizational setting influences the implementation of GIS. Generally, transit organizations operate under two administrative structures - as an independent authority or as part of a larger municipal agency. Each of these structures impacts the implementation and utilization of GIS at a transit agency.

INDEPENDENT AUTHORITY

Agencies that operate as independent authorities act under an advisory board that oversees the activities of the agency. All staffing needs are met within the agency, and the size of the organization may affect the agency’s level of GIS activity. The lack of specialization within such organizations is a disadvantage of this type of structure. Personnel at smaller agencies serve many functions within the organization and opportunities for implementing GIS are a greater challenge. However, a GIS professional working for an independent agency is able to specialize in transit specific GIS applications. Six of Florida’s transit agencies are independent authorities, and two of these agencies do not have a GIS department or any GIS staffing. The remaining four agencies have some GIS activities in more than one department.

DEPARTMENTAL TRANSIT AGENCY

Departmental transit agencies are part of a larger municipal organization and serve as a department of a municipal government. Staffing needs are met by the municipal organization and, in some cases, duties are shared across the organization. For example, a municipality’s GIS department may provide GIS services to the transit...
department as well as other municipal departments. This organizational structure allows the transit agency to enjoy the expertise of a GIS department without investing all the resources to have a GIS staff. However, the GIS needs of a transit agency are unique, and often, a municipality’s GIS department does not understand the GIS needs of the transit agency. The challenge of the transit department is to communicate the needs of the transit department to the GIS department. Often, without a transit GIS professional, the needs are difficult to identify and meet. A total of 20 of Florida’s transit agencies are part of municipal government, and 2 of the agencies indicated having a GIS staff within its transit department. The remaining 18 agencies indicated that staff from another department met its GIS needs.

**Training Availability**

Training is a clear indication of the support an organization has for GIS activities. It suggests a commitment from the organization to invest in GIS activities. Organizations providing staff with GIS training opportunities are creating an environment conducive to a successful implementation and expansion of GIS activities. Seven transit agencies indicated the availability of GIS training opportunities. Three of the agencies were a part of a departmental transit agency. The availability of GIS training opportunities is a clear indication of the support an organization has for GIS activities, suggesting an organizational commitment to invest in GIS activities. Of the surveyed agencies, seven indicated supporting training opportunities for GIS. Among the seven agencies, all but one had very high rates of GIS data and areas of use. The one agency not reporting on the data and areas of use is part of a municipal government, which stores and creates the GIS data. Three of the agencies were a part of a larger organization, and follow-up phone interviews indicated the training was provided by the County GIS department; there was no transit specific GIS training. Two agencies indicated the organization provides the training monthly; both were part of a County government.

**Cooperative Ventures**

Entering into cooperative ventures with GIS groups can effectively grow the extent of GIS experience by tapping into the skills and experiences of the group. Users groups and professional organizations are ideal partnerships for GIS professionals. The survey questioned the type and extent of partnerships within and outside its organization. Eight of the agencies indicated working cooperatively with GIS departments from other agencies with GIS. Many of the agencies worked with MPO staff or a local municipal government staff to assist with GIS. Some agencies indicated using consultants to assist with the GIS activities within their organization. Some groups worked with GIS user groups for assistance and sometimes shared data. A user group brings other area GIS users together to share techniques, and often data.
Software Used

The type of software used by the transit agency does not indicate an organizational support. However, agencies using more than one platform often indicate the support from management to utilize many GIS tools to meet the transit agencies needs. Among the agencies using GIS, all but one indicated using more than one GIS application. Figure 4 indicates the number of applications transit agencies are using in Florida. Among the GIS applications utilized, nearly all the agencies indicated using some ESRI GIS application. Figure 5 illustrates the distribution of GIS applications among Florida’s agencies.

Figure 4
Number of GIS Applications Utilized in Florida Transit Agencies
To address this issue, the survey asked several questions including the department and number of average weekly hours dedicated to GIS activities; the availability and frequency of training opportunities; which departments are solely responsible for GIS; and what cooperative ventures were being undertaken. Examining these issues established a better understanding of how the organization supports its GIS activities.

Some agencies had a GIS department within their agency; others, which were part of a municipal government, relied on another department for the data; others were a hybrid, creating and storing their own data, and using other departments’ data to complement their own data. In this situation, there was a great deal of data sharing between departmental GIS groups.

**IMPLEMENTATION AND MANAGEMENT CONCerns**

The transit agencies were asked to provide a list of pressing needs and concerns regarding the implementation and management of GIS activities at their agency. The survey asked questions regarding the types of resource and technical assistance that are needed to help implement GIS and how GIS could benefit the agency. The agencies expressed a variety of concerns and needs about personnel, training, and managing the data. Two of the responses illustrate the pressing needs of the agencies for efficiency and training: one respondent stated that “GIS Data Maintenance is time consuming, but other job responsibilities such as user requests, analysis, and application development become part of the GIS needs for the organization…” Another responded with concerns about “time constraints. [Our] transit division is new to the list of county departments using GIS. We have just had it installed on two
computers and are in the beginning stages of using GIS and learning how to use it to our benefit. Therefore, our use of GIS is currently a ‘project’ that gets attention only when more pressing issues are not at the surface of daily … administration. Once we have had the time to become more comfortable with GIS and have some GIS projects set up, we will be using it on a more daily basis. Right now, we’re just beginners.”

The majority of the respondents noted that the most pressing issue concerning implementation and management was training, data maintenance, and integration of GIS into more areas of the agency.

Training

It was clear by the high number of responses to this question that the agencies were looking for assistance in the area of GIS. The single largest issue was training. However, there was a vast difference among the areas of training that were requested. Some agencies were looking for assistance with data management and conversion, while others were looking for transit specific GIS techniques. Some of the agencies were looking for auto-routing and Internet mapping capabilities, while others were looking for best practices, so they wouldn’t have to “reinvent the wheel.” Several of the agencies indicated the desire for greater funding, more time to work with GIS, and a larger staff. It was clear that the respondents to the survey wanted to do more with GIS but didn’t have the resources (time, money, or skills) to do more with GIS. Many indicated they would like to have training opportunities and workshops to help with implementing their GIS.

Data Access and Management

In addition to training, many agencies identified data issues as the most pressing concern with GIS. Again, the types of data concerns were varied based on the level of GIS activity. Some agencies with advanced GIS operations were challenged with maintaining data integrity while meeting other responsibilities. Other agencies were looking for techniques to automate data collection efforts and to integrate the GIS with other activities more seamlessly. The low-use agencies expressed concerns about accessing GIS data such as route and Census-related demographic data.

Capital and Human Resources

Additionally, there were several agencies that indicated they needed funding or more workforce. These comments were usually related to the large efforts to maintaining the large GIS databases, to implement new software, or take advantage of some of the more advanced GIS applications. Agencies indicated they were looking for more advanced techniques for performing analysis.
It was evident that the agencies were eager to implement or increase the level of GIS usage and take advantage of its benefits, but training and resource allocation were considered the most significant barriers to them taking advantage of GIS.

**Benefits of GIS Implementation**

Nearly all of the agencies, even agencies without GIS, responded to the question of the benefits of GIS, most frequently in the area of planning. Agencies indicated they found that GIS helped most with service planning. Additionally, they indicated that GIS helped with scheduling, creating efficiencies within their daily operations, and communicating transportation issues with GIS mapping. Some agencies with more advanced use of GIS indicated the benefits of integrating AVL systems and APC with their GIS system.

**Summary of Survey Findings and Trends in Florida Transit GIS**

Using GIS applications, Florida’s transit agencies are able to efficiently and effectively analyze, measure, and illustrate the conditions of the transit system. Florida’s transit agencies have increased the use of GIS since the 1995 study. Transit agencies have made great strides in the area of GIS since 1995, but there are indicators that GIS is being used in a limited manner.

In nearly all data categories, transit agencies have increased the usage and storage of GIS data. Agencies are storing more data and are utilizing GIS applications in a larger variety of areas. Agencies indicating the use of GIS within their organization increased dramatically from 33 percent to 73 percent. Additionally, agencies are utilizing and storing more GIS data than in 1995. Figure 6 illustrates the increasing number of GIS datasets that transit agencies are storing compared to agencies in 1995. Furthermore, the breadth of the data utilized by the agencies has become more focused on transit specific data sets such as route and stop inventories, and demographic and census data. Figure 7 illustrates the types of data stored in 1995 and 2002.
Figure 6
Comparison of GIS Data Storage in Florida Transit Agencies, 1995-2002

- Broward Transit Division
- City of Key West/Dept. of Transportation
- Collier Area Transit
- Escambia County Area Transit
- Gainesville Regional Transit System*
- Hillsborough Area Regional Transit Authority
- Indian River County Transit System
- Jacksonville Transportation Authority
- Lakeland Area Mass Transit District
- Lee County Transit Division
- Lynx (Central Florida R.T.A.)
- Manatee County Area Transit
- Martin County Transit
- Miami Beach (ELECTROWAVE)
- Miami-Dade Transit
- Okaloosa County Transit**
- Palm Beach County Surface Transportation Dept (PalmTran)
- Panama City Urbanized Area MPO (Bay County)**
- Pasco County Public Transportation
- Pinellas Suncoast Transit Authority
- Sarasota County Area Transit (SCAT)
- Space Coast Area Transit (Brevard County)
- SunTran (Ocala/Marion County Public Transit System)
- Suwanee Valley Transit Authority
- TALTRAN
- VOTRAN
Figure 7
Comparison of GIS Data Storage in Florida Transit Agencies, 1995-2002
Several factors may have contributed to the increased usage of GIS. Changes in software and hardware costs as well as advances in desktop GIS applications may have contributed to the increased use among transit agencies. Additionally, a consolidation of GIS applications among Florida’s transit systems may be a reason for the increase. In 1995, Florida’s transit agencies were using five different GIS applications among the six transit agencies using GIS. The highest response category for the transit agencies in 1995 was “Other” with four (67%). In 2002, the distribution of GIS applications was not as dispersed. Ten transit agencies (62%) reported using ESRI products and the next closest application was Trapeze with three positive responses (19%). The trend towards software consolidation will lead to data uniformity. The 1995 study indicated that a significant concern among transportation agencies was translating and converting GIS data. By utilizing the same applications, transit agencies no longer need to translate and convert files into a compatible format.

Another factor that may contribute to the increase in GIS utilization may be the size and organizational structure of the transit agency. Generally, the larger the transit organizations utilized GIS at a greater level than smaller agencies. The activity levels at the medium-sized agencies varied but the survey was unable to establish to what extent. Smaller transit agencies had little or no GIS activities.

The organizational structure did not have a noticeable impact on the utilization of GIS. While there are possible advantages for independent authorities and departmental transit agencies, the data do not indicate that one type utilized GIS more than another. Agencies that are stand-alone, independent authorities are able to specialize in transit specific GIS applications. However, if the agency is unable to hire a GIS specialist, there is little opportunity to capitalize on such a structure. Additionally, agencies that are part of a larger municipal organization are able to capitalize the city or county GIS department’s expertise. However, a departmental GIS approach lacks the transit specific GIS expertise necessary for a transit agency. Independent authority agencies use GIS at a slightly higher rate than departmental agencies.

In spite of this increase in usage, transit agencies may not be utilizing GIS to its fullest capacity. Certain indicators from the survey and the follow-up phone calls are illustrative of the extent that GIS is being utilized. Different types of datasets are good barometers for GIS usage. The creation, maintenance, and utilization of the bus stop inventories are a good indicator of the extent of GIS utilization. Florida’s transit agencies have not significantly increased the utilization and storage of the bus stop inventory.

The creation of a bus stop inventory is an arduous process simply because of the size of the data collection effort. Collecting the location and descriptive attributes of between 3,000 to 8,000 bus stops is daunting for most transit agencies. Since 1995,
the number of transit agencies storing a bus stop inventory in a GIS increased by only one. (In 1995, seven transit agencies indicated having a bus stop inventory.) Transit agencies have not increased the utilization of bus stop inventories from 1995, suggesting that the agencies are not able to successfully collect and manage this dataset.

Florida’s transit agencies have clearly embraced transit GIS and have expanded its use significantly; however, transit agencies have opportunities to further capitalize on the benefits of GIS. Greater utilization of the bus stop inventory is critical for this next step. Additionally, transit agencies should commit to establishing GIS as the foundation of their planning efforts by providing access to GIS data to many other members of the organization and creating a distributed information network which many departments are able to access and analyze. GIS should be an integrated part of the transit operations and planning. If the current trend continues, Florida’s transit agencies will continue to accrue the benefits of GIS.
SECTION 4: BUS ROUTE AND STOP DATA COLLECTION AND UPDATES

A large part of this project involved collecting and translating GIS layers for implementation into the (FTIS). The data collected consisted of the transit routes and transit stops. The project was not to create any data but rather to contact the transit agencies and request the most up-to-date transit GIS information. Depending on the transit agency, some had an up-to-date version of its route and stop inventories; others had only routes, and some had no data available at all. In some instances, the data that were available were created as part of the transit development plan process and did not have a system to regularly update the GIS data. Few had bus stop inventories available, but those that did had no process to maintain and update the inventories, consequently, the data were not up to date.

All of the data collected was to be used by the most up-to-date version of FDOT’s FTIS. To facilitate that process, the data layers were standardized.

GIS AT FLORIDA’S TRANSIT AGENCIES

The following is a detail of the data collected for each transit agency.

Bay Town Trolley

Bay Town Trolley does not currently utilize an in-house GIS department and relies on the West Florida Regional Planning Council (WFRPC) for any transit-related GIS assistance. The WFRPC has provided the most current GIS data, last updated in January of 2003. The data consist of route data in master and individual route format, as well as route attribute data. The stops layer was created by CUTR from extremely generalized data provided by WFRPC, which has never tracked stops. Consequently, the layer is inaccurate and should not be used for analysis.

Brevard County Space Coast Area Transit (SCAT)

Brevard County SCAT does not currently utilize an in-house GIS department and relies on Brevard County for any transit-related GIS assistance. CUTR houses the most current GIS data for SCAT, obtained in 2000 prior to the undertaking of this project. The data consist of route and stop data. Route data are formatted in a master route file only (no individual routes). No attribute data for routes or stops exist at this time.
Broward County Transit

The Broward County Transit in-house GIS contact provided the most current GIS data, last updated in January 2003. The data consist of route and stop data, as well as attribute data for routes and stops. Although route data are formatted in a master route file, individual routes may be determined from route attributes.

Collier Area Transit (CAT)

CAT is a section of the Department of Alternative Transportation Modes, in the Collier County Transportation Division. CAT does not currently utilize an in-house GIS department and relies on the Collier County Transportation Division for any transit-related GIS assistance. CUTR houses the most current GIS data for CAT, obtained in 2002 prior to the undertaking of this project. The data consist of route data and route attributes. Route data are formatted in master and individual route files. No stops or stop attributes exist at this time.

Escambia County Area Transit (ECAT)

Escambia County Area Transit does not currently utilize an in-house GIS department and relies on the WFRPC for any transit-related GIS assistance. WFRPC has provided the most current GIS data last updated in November of 2002. The data consist of route data in master route format only (no individual routes). Because ECAT does not use fixed stops, the stops layer is only a generalized representation and should not be used for analysis. No route or stop attribute data exist at this time.

Gainesville Regional Transit System (RTS)

CUTR houses the most current GIS data for Gainesville RTS, obtained in 2000 prior to the undertaking of this project. The data consist of route and stop data. Route data are formatted in a master route file only (no individual routes). No attribute data for routes or stops exist at this time.

Hillsborough Area Regional Transit Authority (HARTline)

HARTline’s in-house GIS contact provided the most current GIS data, last updated in March 2002. The data consist of route and stop data, as well as route attribute data. Although route data are formatted in three separate master route files (all routes, express routes, and local routes), individual routes may be determined from the route attribute data. Stop data are flawed due to translation from Trapeze software, showing two stops at the same location instead of across the street from one another. No stop attribute data exist at this time.
The Hernando Express

The Hernando Express was contacted to request any GIS data utilized by the agency in its operations. The Hernando Express is a new transit system that began operations in late 2002 and no response was received.

Indian River County Transit System

At this time, Indian River County Transit System does not utilize GIS. However, CUTR houses the most current GIS data for Indian River County, obtained in 2000 prior to the undertaking of this project. The data consist of route and stop data. Route data are formatted in a master route file only (no individual routes). No attribute data for routes or stops exist at this time.

Jacksonville Transportation Authority (JTA)

The JTA Service Planning Department GIS contact provided the most current GIS data, which was updated in 2002. The data consist of route and stop data, as well as route and stop attributes. Route data are formatted in master and individual route files. JTA also provided a point file of all stops for the Automated Skyway Express (ASE), an elevated rail system that carries passengers between elevated stations.

Key West Department of Transportation

At this time, the Key West Department of Transportation does not utilize GIS. However, CUTR obtained GIS route and stop data in 2000, prior to the undertaking of this project. Route data are formatted in a master route file only (no individual routes). No route or stop attribute data exist at this time.

Lakeland Area Mass Transit

Lakeland Area Mass Transit does not currently utilize an in-house GIS department and relies on the Polk County Transportation Planning Organization (TPO) for any transit-related GIS assistance. The Polk County TPO provided updated route and stop data, as well as route attributes. Route data are formatted in a master route file, as well as separate files for regular routes and connector routes. No stop attribute data exist at this time.

Lee County Transit (LeeTran)

LeeTran does not currently utilize an in-house GIS department and relies on the Lee County GIS Department for any transit-related GIS assistance. Although CUTR houses GIS route and stop data, as well as route and stop attributes, the data were obtained prior to the 2001 restructuring of LeeTran’s routes and stops. Consequently,
the data are not up-to-date and should not be used for analysis. The LeeTran Planning Department has provided a non-GIS database of stops last updated in March 2003. However, much of the amenity and coordinate information is missing; thus, the database is incomplete.

**LYNX**

The LYNX Planning and Technology Department provided the most current GIS data, last updated in August 2002. The data consist of route and stop data, as well as route and stop attributes. Although route data are formatted in a master route file, individual routes may be determined from the route attribute data.

**Manatee County Area Transit (MCAT)**

MCAT does not currently utilize an in-house GIS department and relies on the Manatee County Information Services Department (ISD) for any transit-related GIS assistance. The Manatee County ISD provided updated route and stop data. Route data are formatted in a master route file only (no individual routes). No route or stop attribute data exist at this time.

**Martin County Transit**

Martin County Transit does not currently utilize GIS. No GIS data for Martin County Transit exist at this time.

**Metro-Dade Transit**

The Information Technology Services Department of Metro-Dade Transit provided the most current GIS data. The data consist of route data and attributes last updated in August 2002, and stop data and attributes last updated in January 2003. Although data are formatted in a master route file, individual routes may be determined from the route attribute data.

**Miami Beach (Electrowave)**

Miami Beach Electrowave does not currently utilize GIS. However, CUTR houses the most current GIS data for Electrowave, obtained in 2000 prior to the undertaking of this project. The data consist of routes, route attributes, and Electrowave facilities. Route data are formatted in master and individual route files. No stop data of any kind exist at this time.
Ocala/Marion County Public Transit System (SunTran)

SunTran does not currently utilize GIS. However, as part of the technical assistance program, CUTR was able to create GIS route data from information on the SunTran website (www.suntran.org). These data were created in both master route and individual route format. No route attributes or stop data of any kind exist at this time.

Okaloosa County Transit

Okaloosa County Transit does not currently utilize an in-house GIS department and relies on Okaloosa County for transit-related GIS assistance. CUTR houses the most current GIS data for Okaloosa County Transit, obtained in 2002 prior to the undertaking of this project. The data consist of route, stop, and transfer center data, as well as route and stop attributes. Route data are formatted in master and individual route files. Stop data consists of stops for red, blue, and Crestview routes only.

PalmTran

PalmTran does not currently utilize an in-house GIS department and relies on the Palm Beach Metropolitan Planning Organization (MPO) for any transit-related GIS assistance. The Palm Beach MPO provided the most current GIS data last updated in August 2002. The data consist of routes and route attributes. Although route data are formatted in a master route file, individual routes may be determined from route attributes. The Palm Beach MPO is in the process of creating a GIS database of stops. Until the completion of this database, CUTR houses the only GIS stop data for PalmTran. Because it was obtained prior to the restructuring of PalmTran’s stops, the data are inaccurate and should not be used for analysis.

Pasco County Public Transportation

CUTR houses the most current GIS data for Pasco County Public Transportation, obtained in 2000 prior to the undertaking of this project. The data consist of route and stop data. Route data are formatted in a master route file only (no individual routes). No attribute data for routes or stops exist at this time.

Pinellas Suncoast Transit Authority (PSTA)

At this time, PSTA has no in-house GIS department. However, CUTR houses 2002 GIS data and attributes for routes, stops, and PSTA facilities. Although route data are formatted in a master route file, individual routes may be determined from route attributes.
Polk County InterCity Transit Service

Polk County InterCity Transit Service does not currently utilize an in-house GIS department and relies on the Polk County Transportation Planning Organization (TPO) for any transit-related GIS assistance. The Polk County TPO provided the most current GIS data, last updated in October 2002. The data consist of routes and route attributes. Although route data are formatted in a master route file, individual routes may be determined from attribute data. No stop data or attributes exist at this time.

Sarasota County Area Transit (SCAT)

SCAT is in the process of creating a GIS database for its routes. Until the completion of this database, CUTR houses the most current GIS data for SCAT, obtained in 2002 prior to the undertaking of this project. The data consist of route and route attribute. Although route data are formatted in a master route file, individual routes may be determined from the route attributes. No stop data or stop attributes exist at this time.

Suwannee Valley Transit

No response was received from Suwannee Valley Transit regarding the use of GIS.

TALTRAN

The TALTRAN in-house GIS contact provided shapefiles for the routes that were updated after the release of the year 2000 FTIS CD. The data sent to CUTR consist of four shapefiles for routes 4, 5, 12, and 19, which were updated in 2002. These shapefiles were merged with the 2000 FTIS GIS data after removing the outdated routes. The data consist of route and route attribute data. Although route data are formatted in a master route file, individual routes may be determined from the route attribute data. CUTR houses the most current GIS stop data for TALTRAN, obtained in 2000 prior to the undertaking of this project.

Volusia County Public Transit System (VOTRAN)

VOTRAN does not currently utilize an in-house GIS department and relies on Volusia County for any transit-related GIS assistance. CUTR houses 2002 route and stop data, as well as route attributes. Although route data are formatted in a master route file, individual routes may be determined from route attributes. No stop attribute data exist at this time.
**Winter Haven Area Transit System (WHAT)**

WHAT does not currently utilize an in-house GIS department and relies on the Polk County Transportation Planning Organization (TPO) for any transit-related GIS assistance. The Polk County TPO provided updated routes and route attributes. Although route data are formatted in a master route file, individual routes may be determined from attribute data. No stop data or attributes exist at this time.

A summary of the data collected can be found in the table below. The year the data was created and what data was included in the data request and the status of the data and the data request can all be found in Table 2.
Table 2 Existing Transit GIS Data at Florida’s Transit Agencies

<table>
<thead>
<tr>
<th>Agency Name</th>
<th>Year of Data</th>
<th>Year data obtained</th>
<th>Routes</th>
<th>Stops</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bay Town Trolley (Panama City)</td>
<td></td>
<td>2000</td>
<td>2003</td>
<td>NA</td>
</tr>
<tr>
<td>Brevard County (Space Coast Area Transit)</td>
<td></td>
<td>2000</td>
<td>2000</td>
<td></td>
</tr>
<tr>
<td>Broward County Transit</td>
<td></td>
<td>2000</td>
<td>2003</td>
<td>2003</td>
</tr>
<tr>
<td>Collier County</td>
<td></td>
<td>2002</td>
<td>2002</td>
<td>NA</td>
</tr>
<tr>
<td>Escambia County Area Transit</td>
<td></td>
<td>2000</td>
<td>2002</td>
<td>NA</td>
</tr>
<tr>
<td>Hillsborough Area Regional Transit Authority (HART)</td>
<td></td>
<td>2000</td>
<td>2002</td>
<td>2002</td>
</tr>
<tr>
<td>Indian River County Transit System</td>
<td></td>
<td>2000</td>
<td>2000</td>
<td>2000</td>
</tr>
<tr>
<td>Jacksonville Transportation Authority</td>
<td></td>
<td>2000</td>
<td>2002</td>
<td>2002</td>
</tr>
<tr>
<td>Key West Dept. of Transportation</td>
<td></td>
<td>2000</td>
<td>2000</td>
<td>2000</td>
</tr>
<tr>
<td>Lakeland</td>
<td></td>
<td>2000</td>
<td>2002</td>
<td>2002</td>
</tr>
<tr>
<td>Lee County Transit</td>
<td></td>
<td>2000</td>
<td>2000</td>
<td>2000</td>
</tr>
<tr>
<td>LYNX</td>
<td></td>
<td>2000</td>
<td>2002</td>
<td>2002</td>
</tr>
<tr>
<td>Manatee County Area Transit</td>
<td></td>
<td>2000</td>
<td>2002</td>
<td>2003</td>
</tr>
<tr>
<td>Martin County Transit</td>
<td></td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Metro Dade Transit</td>
<td></td>
<td>2000</td>
<td>2002</td>
<td>2003</td>
</tr>
<tr>
<td>Miami Beach (ELECTROWAVE)</td>
<td></td>
<td>2000</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Ocala/Marion County Public Transit System (SunTran)</td>
<td></td>
<td>2003</td>
<td>2003</td>
<td>NA</td>
</tr>
<tr>
<td>Okaloosa County Transit</td>
<td></td>
<td>2002</td>
<td>2002</td>
<td>2002</td>
</tr>
<tr>
<td>PalmTran</td>
<td></td>
<td>2000</td>
<td>2002</td>
<td>2000</td>
</tr>
<tr>
<td>Pasco County Public Transportation</td>
<td></td>
<td>2000</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>PSTA</td>
<td></td>
<td>2002</td>
<td>2002</td>
<td>2002</td>
</tr>
<tr>
<td>SCAT (Sarasota)</td>
<td></td>
<td>2002</td>
<td>2002</td>
<td>NA</td>
</tr>
<tr>
<td>Suwannee Valley Transit</td>
<td></td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>TALTRAN</td>
<td></td>
<td>2000</td>
<td>2002</td>
<td>2000</td>
</tr>
<tr>
<td>VOTRAN</td>
<td></td>
<td>2002</td>
<td>2002</td>
<td>2002</td>
</tr>
</tbody>
</table>

**STANDARDIZE DATA LAYERS**

All the data collected were converted into an ESRI Shape file and forwarded to FDOT to be included in the FTIS project. The FTIS is a user-friendly software system designed specifically for transit planning applications. Developed for the FDOT by the Lehman Center of Transportation Research (LCTR) at the Florida International University, FTIS comes with all the necessary analysis data and has been envisioned as a one-stop database system for transit planning in Florida. ([http://www.eng.fiu.edu/LCTR/FTis/ftis.htm](http://www.eng.fiu.edu/LCTR/FTis/ftis.htm))
To ensure consistency necessary of the FTIS, a standardization of the data was necessary. CUTR acquired all available transit route and stop information from Florida’s transit agencies and converted the files into a standard file format. Much of the data were acquired via Internet or FTP sites and required data manipulation. The data provided by the transit agencies was in a local projection (State Plane) or was not in a projected coordinate system. For each dataset, the correct projection needed to be identified and then re-projected into a single projection. For several of the datasets, communication with the agency was necessary to help determine the data projection. All the data was re-projected to Universal Trans Mercator (UTM) Zone 17N. CUTR provided the data to LCTR in the shape file format to be integrated into the FTIS system.
SECTION 5: GIS TECHNICAL SUPPORT AND LISTSERV

The technical assistance portion of this project was designed to provide transit agencies with guidance and specific assistance with GIS related issues. A transit GIS listserv was created to provide a forum for transit GIS professionals to help with the implementation and operation of a transit GIS. In addition to the creation of the listserv, GIS technical assistance was provided to several Florida transit agencies in two forms: specific service to address a single GIS issue, and general service to address an overarching need among Florida’s transit GIS departments.

TECHNICAL ASSISTANCE PROGRAM

The technical assistance program provided four transit agencies with specific GIS technical assistance. The activities ranged from creating GIS layers to assistance with coordinating and implementing GIS activities.

Technical Assistance Activities

SUNTRAN

For the Ocala/Marion County transit system, SunTran CUTR created a route system of all six of SunTran routes in a GIS. The data was created into two data formats - one with all six routes included in one layer of data, and another with each route represented by a single layer. These data, while not useful to the agency initially, were forwarded to FDOT for integration into the FTIS system. Furthermore, the data were integrated into the portable mapping system that CUTR will distribute to the agencies as well.

HERNANDO EXPRESS

For the Hernando County Transit system (Hernando Express), a route system in a GIS was created. These data were also created in two data formats - one with all routes included in one layers and another with the entire system stored in a single layer. The information created was integrated into the portable map files and distributed to the agency. Additionally, the data were integrated into the FTIS system to facilitate the use of FDOT’s application.

PINELLAS SUNCOAST TRANSIT AUTHORITY

The Pinellas Suncoast Transit Authority (PSTA) is located on the west coast of central Florida. PSTA presently operates 172 transit coaches on 37 fixed routes and 7 commuter routes. It is an independent transit authority governed by an 11 member
PSTA does not have a GIS department or any internal GIS activities. Consultants provide all GIS services at PSTA.

PSTA was implementing an AVL system which required several GIS data sets including a street dataset with directional information, such as one-way streets, a bus stop inventory stored in a local projection, and a bus stop inventory (BSI) with unique identifier for each bus stop.

PSTA did not have all the data necessary to implement the AVL system. It was necessary to acquire the street dataset from a commercial vendor. Project staff communicated with the vendor, helped establish the data specifications, and recommended a vendor for the street data.

A consultant created PSTA’s bus stop inventory but PSTA staff updated and maintained the data. The data were originally created to meet ADA requirements. Consequently, the data did not meet any of the requirements for the AVL system. Working with PSTA staff, the bus stop inventory was converted and cleaned up to meet the AVL systems requirements. The first requirement of the AVL software was to have a unique feature for each bus stop. The data contained many duplicate data points and the information needed to be cleaned up so that there was only one record for each stop. After discussions about specific needs, PSTA staff cleaned up and created a bus stop inventory that contained only one record for each stop. The bus stop inventory also needed to contain coordinate information for the AVL. The data contained a latitude and longitude coordinate and it needed to contain the coordinates in the units of the local projection, which in this case was State Plane (West) Feet.

Upon completion of the data corrections and input with the street layer, PSTA staff were able to proceed with the implementation of the AVL system.

**Manatee County Area Transit (MCAT)**

Manatee County’s GIS division was utilizing GIS for many departments within the County. However, the transit department, which houses MCAT, was using GIS in a limited manner. To help facilitate the use of the existing GIS capabilities, CUTR staff met with the County’s GIS staff and MCAT to help determine how the two departments can work better together. During the meeting, MCAT’s needs were established and a plan for meeting those needs were set out.

The County’s GIS department houses many GIS layers, and MCAT would benefit from access to several of the datasets including census data and land-use data. The GIS department, utilizing an Internet map service, was able to immediately meet these needs by providing Internet access to the data. The Internet mapping service will allow MCAT staff to view and query the GIS data to help with planning needs.
Additionally, MCAT staff was informed of the ability of GIS to integrate with advanced technologies such as AVL and APC, and a commitment to future meeting was established to capitalize on the potential new opportunities. In general, a plan was established to begin the process of providing the transit department with more data and possibly more utilities to access and analyze the data.

**Establish a GIS Listserv**

To meet the needs of all the agencies, a Transit GIS listserv was created to provide as a sounding board for questions, concerns, and techniques for addressing many different types of GIS needs. The listserv will continue to operate after the close of this project. The listserv is housed at CUTR using the Lyris software and can be accessed: [http://cutrlist.eng.usf.edu/scripts/lyris.pl](http://cutrlist.eng.usf.edu/scripts/lyris.pl).

**Census 2000 GIS Data and Maps**

The survey indicated transit agencies had many differing types of data needs, from database maintenance to access to data not immediately available. It was determined that providing GIS data to Florida’s agencies would meet some of their data needs. Additionally, for agencies with no GIS activities, the most basic GIS data would provide a first step into the implementation of GIS. A data dictionary for shape file and an Access database with column definitions is located at the end of this document in Appendix A.

**GIS Data**

To meet the GIS data needs, GIS files and maps were compiled from the 2000 U.S. Census. Transit-useful census variables were identified, downloaded, and integrated with the transit data into a GIS. GIS files were created from the Census SF3A table at the blockgroup level. Table 3 contains the list of Census tables from which the files were created. All of the 2000 Census data and the resulting GIS files will be distributed to all of Florida’s transit agencies.
### Table 3  
Census Data Tables

<table>
<thead>
<tr>
<th>Table Designation</th>
<th>Data Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>Total Population</td>
</tr>
<tr>
<td>P7</td>
<td>Hispanic or Latino by Race</td>
</tr>
<tr>
<td>P8</td>
<td>Sex by Age</td>
</tr>
<tr>
<td>P26</td>
<td>Place of Work – State and County Level</td>
</tr>
<tr>
<td>P27</td>
<td>Place of Work – Place Level</td>
</tr>
<tr>
<td>P28</td>
<td>Place of Work – MSA Level</td>
</tr>
<tr>
<td>P30</td>
<td>Means of Transportation to Work</td>
</tr>
<tr>
<td>P31</td>
<td>Travel Time to Work</td>
</tr>
<tr>
<td>P32</td>
<td>Travel Time to Work by Means of Transportation</td>
</tr>
<tr>
<td>P36</td>
<td>Sex by School Enrollment</td>
</tr>
<tr>
<td>P37</td>
<td>Sex by Educational Attainment</td>
</tr>
<tr>
<td>P43</td>
<td>Sex by Employment Status</td>
</tr>
<tr>
<td>P48</td>
<td>Family Type by Number of Workers in Family</td>
</tr>
<tr>
<td>P49</td>
<td>Sex by Industry</td>
</tr>
<tr>
<td>P52</td>
<td>Household Income</td>
</tr>
<tr>
<td>P53</td>
<td>Median Household Income</td>
</tr>
<tr>
<td>P87</td>
<td>Poverty Status</td>
</tr>
<tr>
<td>H44</td>
<td>Tenure by Vehicles Available</td>
</tr>
<tr>
<td>H46</td>
<td>Aggregate Number of Vehicles Available</td>
</tr>
</tbody>
</table>

Additionally, other GIS data were created for distribution including county boundary files, Census Tract Boundaries, Urbanized area boundaries, a water file, and a street file. The data were stored in a Geodatabase file format and will be distributed in this format as well as other file formats.
Geodatabase Creation

CUTR will distribute the data created in two different GIS formats. The main format is ESRI’s Geodatabase, which is a geographic database that utilizes a relational database management system. This format was selected because of its ability to store many geographic datasets as well as non-geographic data in a single file. A geodatabase was created for each agency and contains feature datasets (GIS files) and a data file. The feature datasets contain the geography files, which were divided by geography type. The data were organized in this manner for ease of use and can be found in Table 4.

Table 4
Geodatabase Structure

<table>
<thead>
<tr>
<th>Geodatabase Features</th>
<th>Data Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Census Data</td>
<td>Census Data</td>
</tr>
<tr>
<td>Lines Feature Class</td>
<td>County Roads</td>
</tr>
<tr>
<td></td>
<td>Bus Routes</td>
</tr>
<tr>
<td></td>
<td>Major Roads</td>
</tr>
<tr>
<td>Points Feature Class</td>
<td>Bus Stops</td>
</tr>
<tr>
<td>Polygon Feature Class</td>
<td>Census Blockgroups</td>
</tr>
<tr>
<td></td>
<td>Census Tracts</td>
</tr>
<tr>
<td></td>
<td>County Boundary</td>
</tr>
<tr>
<td></td>
<td>Urbanized Area Boundary</td>
</tr>
<tr>
<td></td>
<td>¼ and ¾ Mile Service Area Boundary</td>
</tr>
</tbody>
</table>

Portable Map Files

To view and read the GIS data, portable map files were created. The map files were created by ESRI’s ArcPublisher extension and can be read by ESRI’s ArcReader software, a free downloadable software, which allows the user to interact with GIS data and maps. This allows the agencies to still have the opportunity to utilize the dynamic features of a GIS environment, albeit with limited capabilities. It will allow the agencies to pan, zoom, identify, and query within the maps, as well as utilize the bookmarks created and create layouts for printing purposes. For the agencies without access to GIS, it affords them the opportunity to view their data in a dynamic environment that does not require extensive training beforehand. Maps for each agency were created with much of the collected data integrated into the maps. A map series was created for each transit property. The map series features pertinent variables for transit properties. Table 5 lists all the maps created for each transit agency.
### Table 5
Map Series

<table>
<thead>
<tr>
<th>Map Series</th>
<th>Map Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Map</td>
<td>An interactive map with bookmarks and much of the collected data. The more detailed data is viewed by zooming in closer.</td>
</tr>
<tr>
<td>Population</td>
<td>A map showing the population totals.</td>
</tr>
<tr>
<td>Minority</td>
<td>A map showing the Minority totals.</td>
</tr>
<tr>
<td>Under 18</td>
<td>A map showing the Under Age 18 population totals.</td>
</tr>
<tr>
<td>Over 60</td>
<td>A map showing the Over Age 60 population totals.</td>
</tr>
<tr>
<td>Utilization of public transportation</td>
<td>A map showing the population using public transportation.</td>
</tr>
<tr>
<td>Income under $10,000</td>
<td>A map showing the Households with income below $10,000.</td>
</tr>
<tr>
<td>Households without a vehicle</td>
<td>A map showing the households without a vehicle.</td>
</tr>
</tbody>
</table>

### BASE MAP

The base map file is a unique file in that it was created to be interactive. Within the maps, three different bookmarks were created: system wide view, route level detail, and stop level detail. The system wide view is a view of the entire route system within the county(ies) system services. This bookmark includes the serviced and surrounding counties, census tract boundaries, water, urban areas serviced, and the route system. The route level detail looks at the system at the route level, consisting of all or a portion of each individual route. This bookmark includes census tract boundaries, block group boundaries joined with census data attributes, major roads within the county(ies), and the route system. This and the next map are designed for panning around and querying within the system for individual agencies’ analysis purposes. The stop level details view the system at the stop level, consisting of a portion of each individual route. This bookmark includes block group boundaries joined with census data attributes, all roads within the county(ies), all bus system stops, and the route system. The scale for each bookmark is relative to the system being investigated, and each bookmark is designed to maximize the analysis capability and the viewability of each transit system. The maps are also designed for zooming in and out while maintaining consistent views and smooth transitions from one level of detail to the next.
DEMOGRAPHIC MAPS

From the base map, a series of census data maps was created for each transit agency. This was done using the attributes joined to the block group boundary layers. For the route level detail and the stop level detail bookmarks, thematically shaded maps were created based on selected census data at the block group level. All data was analyzed using the raw numerical value. This led to the creation of a total of eight different maps, designed for panning at the route level detail and stop level detail bookmarks. These maps analyzed the numerical counts existing in each block group (i.e., number of households without a vehicle).
A Geographic Information Systems (GIS) provides transit agencies with an ability to analyze, organize, and distribute information about its system performance and service. The potential benefits of a transit GIS system are recognized by FDOT, evidenced through its support of the transit agencies through the creation of the Florida Transit Information System (FTIS), which has a GIS component to it. The FTIS software provides the most basic of analytical tools to assist Florida’s transit agencies. Transit agencies have continually recognized the importance of GIS to their success. A GIS improves the ability of the agency to communicate the conditions of a transit system and to analyze the performance of the agency. A GIS can provide greater efficiency in the operations and planning for the agency and by embracing GIS a transit agency is able to operate more efficiently.

Embracing a technology like GIS is easier said than done. However, there are steps an agency can take to ensure a more successful GIS implementation. The first step is for transit agencies to recognize and accept that, while complex and sometimes overly cumbersome, the benefits far outweigh the initial costs of implementation. The second step is to recognize that GIS is more than a software application. It is an integrated system of software, data, hardware, and personnel that organizes, manipulates and analyzes spatially related data. By understanding all of the elements of a GIS the agency will not make the mistake of buying the software and thinking it has implemented a Transit GIS. By embracing these two basics, an agency can begin the process of implementing a GIS.

Based on the findings of this study, the following are recommended for Florida’s transit agencies and FDOT.

**Invest in GIS**

Implementing a transit GIS program at a transit agency will require an investment, in both human and capital resources. Primarily this investment must come from within the transit agency, but FDOT should make further commitments as well. A cooperative effort will help ensure the successful implementation of a GIS.

Transit agencies should commit to making an investment in GIS. Transit agencies without a GIS staff should have at least one “expert” GIS professional to specifically address the unique challenges that transit GIS presents. This expert will be able to immediately begin providing GIS services to the agency but more importantly the “expert” will be able to develop an implementation plan that specifically addresses the needs of the transit agency. Agencies should keep in mind that creating a GIS for an agency is not an overnight accomplishment. GIS consists of hardware, software, data, and personnel. A deliberate and well thought-out plan will ensure a successful
implementation. A first step of such a plan must start with an investment in personnel. Independent transit authorities should create a GIS position or create a partnership with the local MPO staff to assign a GIS professional to meet the needs of the agency. Working with this individual, the agency will be able to better develop what its GIS needs. Agencies that are part of a larger organization should request that a single individual from the GIS department be dedicated to creating and managing the transit GIS data. This person will also become a source when greater implementation is considered. Additionally, departmental agencies should capitalize on the training opportunities provided by the GIS department to facilitate training opportunities for staff in the transit department. Not all transit agencies need to immediately utilize an enterprise GIS system, which integrates the APC and AVL technologies so that the current passenger loads and the bus location are seen in real time. But, if an agency wants to implement such a system, the GIS provides a foundation for such activity.

Develop GIS Training

Transit agencies must invest in the capital and human resources to successfully implement a GIS. However, FDOT has a role in the transit agencies’ success. The survey indicated that, regardless of the level of GIS activity, all the transit agencies were looking for some kind of GIS training. From the most advanced to the novice, the agencies are looking for expertise and guidance. Training opportunities should include implementation strategies, techniques, and practices in GIS as well as providing guidance for transit specific applications in GIS. FDOT should ensure that transit specific GIS training opportunities are made available to the transit agencies. More advanced training opportunities should also be made available for agencies already using GIS applications. The more advanced users do not capitalize upon many opportunities, and FDOT should create training opportunities to respond those needs. Some of the areas that agencies indicated wanting to get GIS training include:

- Internet mapping
- Auto-routing capabilities
- Automatic data collection techniques
- Automatic report writing for GIS data
- Integrating GIS with other advanced technologies such as Automatic Passenger Counters (APC), Global Positioning Systems (GPS) and Automatic Vehicle Location (AVL)
Establish Best GIS Practices

Overall, Florida’s transit agencies are making great strides towards implementing GIS within its organizations. However, the agencies are working through implementation issues without much guidance. Creating the foundation from which a robust GIS can be developed has many complex and technically difficult conditions. FDOT should help establish best GIS practices at transit agencies to provide guidance to the agencies. For example, best practices in creating bus stop inventories, designing data structures for bus routes, and other established practices would help agencies to capitalize on successes of other agencies. FDOT should offer guidance, in the following areas:

- GIS implementation
- Data analysis
- Data structure

A guidebook that examines the resources and best practices in these areas would be a significant first step for the agencies to implement and expand GIS operations.

GIS IMPLEMENTATION

An agency must consider many issues while implementing a GIS. To help with implementation, FDOT can establish the needs and analytical capabilities of the GIS to help the agencies with identifying and selecting a GIS resource. By offering this resource, Florida’s transit agencies can capitalize on the expertise of FDOT staff and implement a robust GIS.

DATA ANALYSIS

FDOT should investigate transit specific analytical techniques used with GIS and illustrate the best practices. Additionally, FDOT should sponsor the creation of software add-ons, which create one button analysis in existing GIS applications to provide the agency with a better GIS toolbox. Examples of such add-ons are:

- In-field data collection utilities using portable digital assistant (PDA) and global positioning system (GPS);
- Service area analysis for routing alternatives;
- One button report writing applications which call upon the GIS data;
- Interface to assist with maintaining and updating a bus stop inventory; and
• Interface to assist with automating data collection efforts.

DATA STRUCTURE

The GIS profession is guided by database standards that allow the GIS to perform consistent analysis and allow for systematic data updates and maintenance. By providing guidance to the agencies in the area of database design, the activities of the agencies can involve maintaining and keeping an up-to-date, robust dataset, instead of trying to discover the best techniques for database structure and maintenance. This, in turn, would create greater efficiencies within the organization. Some examples of transit GIS data models include the following:

• Bus stop inventories
• Transit route data model
• Dynamic segmentation for routing and stop locations
• Integrated geo-spatial database storing many modes and transportation features

Future Directions

GIS technologies are evolving everyday, with the development of new applications, and better data designs to improve the manner in which GIS is conducted. There are several areas where Florida’s transit agencies should be aware of for future considerations.

• Portable GPS and GIS applications
• Integrating AVL APC technologies with GIS
• Data models
• Enterprise GIS

PORTABLE GPS AND GIS APPLICATIONS

Great advances in microcomputers and database design have made portable GIS and GPS applications a reality. Portable GIS applications and handheld portable digital assistants (PDA) are able to communicate with GPS hardware to create opportunities
to collect, manage and edit GIS data in the field. Such applications would assist transit agencies with collecting and maintaining a bus stop inventory.

**INTEGRATING AVL AND APC TECHNOLOGIES WITH GIS**

Technologies such as AVL and APC are becoming more closely related to GIS, and often these technologies will employ some GIS element to help manage and communicate with the database these technologies are using. It is important for the transit agencies to realize the close relationship of these technologies to ensure that they are able to integrate the AVL/APC with either its existing or future GIS operations.

**DATA MODELS**

A trend in GIS is the creation of data models. Data models are designed to optimize the strengths of the database and geo-spatial elements of the GIS. They provide a structure from which data and spatial analysis are an integral part of the manner in which the data is designed. For example, a transit data model would allow an agency to create a GIS route file that would automatically store pertinent transit information such as route mileage, service frequency, ridership and service area characteristics. This same model would also store information about the buses that serve that route and information about the bus stop inventory. Data models are an integrated data format that provides information about the system in an automated process.

**ENTERPRISE GIS**

Agencies should also be aware of the trend towards enterprise GIS, which is a GIS system that allows many users to access, manage, manipulate and edit a single large GIS database. The enterprise GIS is a distributed GIS data system, which eliminates redundancy and facilitates the creation and maintenance of a robust GIS system. For example, using an enterprise based GIS system, a department responsible for maintaining the bus stop inventory would edit a bus stop element and that change would be seen by all other GIS users. If a new shelter was installed in a bus stop inventory, the update to the database would allow some one in a telephone customer service to immediately see that change and be able to report on its existence to customers. Or if there was an Internet based GIS application, that data would be seen on the Internet as the data was added to the database. Such a system would create efficiencies that non-enterprise systems do not enjoy.

**Conclusions**

Florida’s transit agencies have improved the utilization of GIS across the board. The technological advances in GIS are continuing at a rapid pace and by embracing the technology today, Florida’s transit agencies will be able to increase its usage and
improve the way it makes decisions about planning and operations. FDOT should also commit to providing technical expertise in the area of GIS for the agencies. Training, white papers, and research on best practices would be of great benefit to Florida’s transit systems. These lessons learned and best practices will significantly impact smaller agencies, which do not have the resources to implement and utilize GIS within its agencies. The lessons and techniques of larger agencies can benefit the smaller and medium sized agencies. A cooperative effort on the part of FDOT and Florida’s transit agencies will create an environment where GIS is able to flourish and ultimately improve the manner and extent that transit is delivered to Florida’s residents.
## APPENDIX A: CENSUS 2000 VARIABLE

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>State ID Number (12 for Florida)</td>
</tr>
<tr>
<td>County</td>
<td>County ID Number</td>
</tr>
<tr>
<td>Tract</td>
<td>Census Tract Number</td>
</tr>
<tr>
<td>Blkgroup</td>
<td>Block Group Number</td>
</tr>
<tr>
<td>Name</td>
<td>U.S. Census FIPS Code for State, County, Census Tract, and Block Group</td>
</tr>
<tr>
<td>Keylock</td>
<td>Identical to &quot;Name&quot; Field</td>
</tr>
<tr>
<td>Population</td>
<td>Total population</td>
</tr>
<tr>
<td>Minority</td>
<td>Total minority population</td>
</tr>
<tr>
<td>Nonminorit</td>
<td>Total nonminority population</td>
</tr>
<tr>
<td>Under18</td>
<td>Total population under the age of 18</td>
</tr>
<tr>
<td>Over60</td>
<td>Total population over the age of 60</td>
</tr>
<tr>
<td>Over65</td>
<td>Total population over the age of 65</td>
</tr>
<tr>
<td>Workincoun</td>
<td>Workers aged 16 years and over that work in their county of residence</td>
</tr>
<tr>
<td>Workoutcou</td>
<td>Workers aged 16 years and over that work outside their county of residence</td>
</tr>
<tr>
<td>Privatetra</td>
<td>Workers aged 16 years and over using private transportation means to work</td>
</tr>
<tr>
<td>Drovealone</td>
<td>Workers aged 16 years and over driving alone to work</td>
</tr>
<tr>
<td>Carpooled</td>
<td>Workers aged 16 years and over carpooling to work</td>
</tr>
<tr>
<td>Publictran</td>
<td>Workers aged 16 years and over using public transportation means to work</td>
</tr>
<tr>
<td>Bicycle</td>
<td>Workers aged 16 years and over riding a bicycle to work</td>
</tr>
<tr>
<td>Walked</td>
<td>Workers aged 16 years and over walking to work</td>
</tr>
<tr>
<td>Workedhome</td>
<td>Workers aged 16 years and over working at home (no transportation)</td>
</tr>
<tr>
<td>Great30</td>
<td>Workers aged 16 years and over whose travel time to work exceeded thirty minutes</td>
</tr>
<tr>
<td>Great45</td>
<td>Workers aged 16 years and over whose travel time to work exceeded forty-five minutes</td>
</tr>
<tr>
<td>Ptgreat30</td>
<td>Workers aged 16 years and over using public transportation whose travel time to work exceeded thirty minutes</td>
</tr>
<tr>
<td>Ptgreat45</td>
<td>Workers aged 16 years and over using public transportation whose travel time to work exceeded forty-five minutes</td>
</tr>
<tr>
<td>Hsenroll</td>
<td>Total number enrolled in high school</td>
</tr>
<tr>
<td>Colenroll</td>
<td>Total number enrolled in college (undergraduate, graduate, and professional)</td>
</tr>
<tr>
<td>Edu_HS_col</td>
<td>Total population aged 25 years and over that had attained a high school diploma OR attended some college</td>
</tr>
<tr>
<td>Edu_AA_BA</td>
<td>Total population aged 25 years and over that had attained an associate degree AND/OR bachelor's degree</td>
</tr>
<tr>
<td>Military</td>
<td>Total population aged 16 and over employed in the armed forces</td>
</tr>
<tr>
<td>Emp_manu</td>
<td>Civilian workers aged 16 years and over employed in manufacturing</td>
</tr>
<tr>
<td>Emp_agr</td>
<td>Civilian workers aged 16 years and over employed in agriculture, forestry, fishing, and hunting</td>
</tr>
<tr>
<td>Under10k</td>
<td>Households with incomes less than $10,000</td>
</tr>
<tr>
<td>Under20k</td>
<td>Households with incomes less than $20,000</td>
</tr>
<tr>
<td>Over200k</td>
<td>Households with incomes greater than $200,000</td>
</tr>
<tr>
<td>MedianInc</td>
<td>Median household income</td>
</tr>
<tr>
<td>O65_Opov</td>
<td>Those aged 65 and over whose income is at or above the poverty level</td>
</tr>
<tr>
<td>O65_Upov</td>
<td>Those aged 65 and over whose income is under the poverty level</td>
</tr>
<tr>
<td>U65_Opov</td>
<td>Those aged less than 65 whose income is at or above the poverty level</td>
</tr>
<tr>
<td>U65_Upov</td>
<td>Those aged less than 65 whose income is under the poverty level</td>
</tr>
<tr>
<td>No_car</td>
<td>Households without a vehicle</td>
</tr>
<tr>
<td>Car</td>
<td>Households with one or more vehicles</td>
</tr>
<tr>
<td>Agg_car</td>
<td>Aggregate number of vehicles available by household</td>
</tr>
</tbody>
</table>
APPENDIX B: SURVEY INSTRUMENT

Inventory of Transit-Related GIS Systems, Databases, and Applications

A survey conducted by the Center for Urban Transportation Research (CUTR)  
University of South Florida, Tampa, Florida 33620-5350  
(813) 974-3120 Fax (813) 974-5168  
Sponsored by the Florida Department of Transportation

Date:   /   / 2002
Introduction To The Project and Survey

The following survey is part of a Florida Department of Transportation sponsored project titled Statewide GIS Transit Technical Assistance Program. The purpose of the project is to document existing and potential Geographic Information System (GIS) applications in transit planning. Each respondent to the survey will be provided a copy of the inventory report, which will detail transportation-related GIS systems, databases, and applications in the state.

If you have any questions regarding the survey, please contact Mr. Martin Catalá at (813) 974-9791 or the FDOT project manager, Mr. Ike Ubaka at (850) 414-4532. Thank you for your assistance with this important effort.

1. Name of Organization:   
2. GIS Contact(s):
   Name and Title
   Address:  
   City:  State:  Zip Code  
   Phone Number:  FAX Number  
   E-Mail Address:
   Name and Title
   Address:
   City:  State:  Zip Code  
   Phone Number:  FAX Number  
   E-Mail Address:
A. CURRENT USE OF GIS IN YOUR AGENCY

3a. Does your agency currently use GIS? □ YES □ NO
3b. If no, do you have plans to use GIS in the future? □ YES □ NO

If you responded NO to question 3a, you need only complete section H of the survey.
If you responded NO to question 3b, you need only complete the last question (18) of the survey.

4a. Does your organization have a web-based GIS application? □ YES □ NO
4b. If yes, what is the primary purpose of your web GIS application?
   □ Marketing □ Route information
   □ Information dissemination □ Other

5. What department(s) currently use GIS (List up to four). How many hours per week is the GIS system used in each department? (Approximately)

<table>
<thead>
<tr>
<th>Dept.</th>
<th>( )hrs</th>
<th>Dept.</th>
<th>( )hrs</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6a. Do you provide GIS training to your staff? □ YES □ NO
6b. If yes, how frequently (on average)?
   □ Biannually □ Annually □ Other

7. How many years of experience does your GIS staff have?

<table>
<thead>
<tr>
<th>GIS Staff 1:</th>
<th>( ) yrs</th>
<th>GIS Staff 2:</th>
<th>( ) yrs</th>
</tr>
</thead>
<tbody>
<tr>
<td>GIS Staff 3:</td>
<td>( ) yrs</td>
<td>GIS Staff 4:</td>
<td>( ) yrs</td>
</tr>
<tr>
<td>GIS Staff 5:</td>
<td>( ) yrs</td>
<td>GIS Staff 6:</td>
<td>( ) yrs</td>
</tr>
</tbody>
</table>

B. AREAS OF USE: Check all areas in which GIS is currently being used in your organization.

a. □ Transit ridership forecasting  h. □ Title VI monitoring
b. □ Service Planning     i. □ ADA compliance
c. □ Market Analysis   j. □ Police operations
d. □ Transit scheduling and run cutting  k. □ Telephone-based customer information services
e. Map Products: design and publishing (check all that apply)  l. □ Fixed facilities and real estate management (check all that apply)
   □ system maps   □ transit stations
   □ route schedules & maps   □ park and ride lots
   □ operator maps   □ bus stops
f. □ Ridematching (van or cars)  m. □ Paratransit scheduling & Dispatching
  g. □ Transit pass sales  n. □ Fixed-route transit dispatching
  o. □ Automatic Vehicle Location
C. TYPES OF DATA

8a. Does your agency have any GIS-related transit data stored on a computer?  □ YES □ NO

8b. If yes, indicate what types of data are stored electronically:
   a. □ Rail transit routes
   b. □ Bus transit routes
   c. □ Rights of way
   d. □ Bus stops
   e. □ Bus timepoints
   f. □ AVL signposts
   g. □ Traffic signals
   h. □ Transit stations
   i. □ Political boundaries
   j. □ Traffic Analysis Zones
   k. □ Demographic data
   l. □ Accident locations
   m. □ Incidents requiring police response
   n. □ Vehicle maintenance & storage
   o. □ Other Data
   __________________________
   h. □ Park and Ride lots
   __________________________

D. SOURCE OF ROAD NETWORK DATA

9. If you utilize GIS, what is the source of your base road network?
   a. □ Digitized in-house
   b. □ Local MPO
   c. □ State DOT
   d. □ USGS-DLG
   e. □ ETAK
   f. □ TIGER
   g. □ DIME
   h. □ Other (specify):  __________________________
### E. GIS SOFTWARE IN YOUR ORGANIZATION

10. In the following table, indicate the type of GIS packages, such as ArcView etc., currently used in your agency:

<table>
<thead>
<tr>
<th><strong>Department</strong></th>
<th><strong>Software Applications</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>GIS e.g. ArcView, TransCad, MapInfo</td>
</tr>
<tr>
<td></td>
<td>CAD e.g. AutoCAD</td>
</tr>
<tr>
<td></td>
<td>Other (specify) e.g. Access</td>
</tr>
<tr>
<td>Planning</td>
<td></td>
</tr>
<tr>
<td>Scheduling</td>
<td></td>
</tr>
<tr>
<td>Dispatching</td>
<td></td>
</tr>
<tr>
<td>Engineering</td>
<td></td>
</tr>
<tr>
<td>Marketing</td>
<td></td>
</tr>
<tr>
<td>Others (specify)</td>
<td></td>
</tr>
</tbody>
</table>

### F. COMPUTER PLATFORM

Check the operating system used in each department and indicate the number of computers

<table>
<thead>
<tr>
<th><strong>Department</strong></th>
<th><strong>Stand-Alone PC or Mac</strong></th>
<th><strong>Networked PC or Mac</strong></th>
<th><strong>Stand Alone Unix Workstation</strong></th>
<th><strong>Networked Unix</strong></th>
<th><strong>Mainframe or Mini Terminals</strong></th>
<th><strong>Other (specify)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scheduling</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dispatching</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Engineering</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Marketing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Others (specify)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
G. GIS ORGANIZATION

11. Is there a single department responsible for the overall management of the GIS? □ YES □ NO
   If yes, name the department: ________________________________

12. Indicate who is responsible for maintaining/updating the base map and databases for your system.
   □ Single department (name): ________________________________
   □ Joint responsibility (two or more depts): ____________________
   □ Committee: ________________________________
   □ Other: ________________________________

H. IMPLEMENTATION STRATEGY:

13. Do you have plans to implement, expand or enhance your GIS system? □ YES □ NO
   Check the general time frame most applicable:
   □ 0 - 6 months □ 6 mos. - 1 yr □ 1 - 2 yrs □ 2+ yrs

14. Does your organization utilize GIS through cooperative ventures with consultants or other agencies? □ YES □ NO
   Please list: ________________________________

15. What do you consider the most pressing issue or concern your organization has had to face in terms of planning, developing, and/or managing a GIS system?
   ________________________________
   ________________________________
   ________________________________

16. What do you consider the most important or beneficial application of GIS in your organization?
   ________________________________
   ________________________________
   ________________________________

17. What type of technical support do you think would be helpful for your organization to utilize GIS?
   ________________________________
   ________________________________
   ________________________________

18. If your organization does not plan to implement GIS, what is the reason for this decision?
   ________________________________
   ________________________________
   ________________________________

THANK YOU
APPENDIX C: DIRECTIONS FOR INSTALLING AND OPERATING ARCREADER

All the published map files are designed for viewing with the software ArcReader, included with this CD.

How to install ArcReader and the map files

1) Double-click on “My Computer” on the Desktop, and then select the CD drive (often drive D:\ or E:\).
2) Open the ArcReader folder on the CD.
3) Double-click on the setup icon.
4) The software will check the computer for installed components.
5) A welcome screen will pop up when the software is done checking the computer. Click Next.
6) Read the ESRI Licensing Agreement that appears. To continue the installation process, click Accept the Agreement.
7) Choose the installation type. It is recommended that “Typical” be chosen. Typical will run all necessary components off of the CD and will take the shortest amount of time to install. If wished, perform the complete installation, which will take longer. The custom installation is NOT recommended. Then, click Next.
8) The system will choose a default destination folder. Click Next to accept the destination.
9) At this point, the software is ready for installation. Click Next to begin installation.
10) ArcReader is now installed on the computer and ready for reading the included maps.

Accessing the included Published Maps:

Option 1: Storing the maps and data on the computer’s hard drive

1) Double-click on “My Computer,” then select the CD drive.
2) Right-click on the FTGIS folder, and choose Copy.
3) Select the location you wish to place the FTGIS folder, right click and choose Paste. It may take some moments for the entire dataset to copy to the hard drive.
4) From the task bar, click: Start -> Programs -> ArcGIS -> ArcReader.
5) Once ArcReader opens, click File -> Open (or click the Open icon).
6) Under “Look in,” browse for the FTGIS folder. The maps will be located in the Transit agency folder, then the ArcReader folder, which will hold all the available maps.
7) Select a map. Click Open.
Option 2: Reading the maps directly from the CD

1) From the task bar, click Start -> Programs -> ArcGIS -> ArcReader
2) Once ArcReader opens, click File -> Open (or click the Open icon)
3) Under “Look in,” browse for the CD drive. The maps will be located in the Transit agency folder, then the ArcReader folder, which will hold all the available maps.
4) Select a map. Click Open.

How to work in ArcReader

- Map will initially open at the Stop Level Detail bookmark. *To use the bookmarks*, which show different scale levels for the system view, the route level detail and the stop level detail:
  - View -> Bookmarks -> (The bookmark you wish to view)

- *To pan throughout the screen*: Tools -> Data -> Pan OR click on the Pan icon at the top of the screen (looks like a hand)

- *To zoom in or out*: Tools -> Data -> Zoom In/Zoom Out OR click on the Zoom In/Zoom out icons at the top of the screen; then draw a box around the area of the screen to view

- *To change viewed layers*: View -> Table of Contents OR click on the Table of Contents icon at the top of the screen; then click the checkmark beside each layer to turn it on or off. Note that each layer has a specific scale set for that layer; the defined scale of the layer cannot be altered in ArcReader.

- *To identify specific features*: Tools -> Data -> Identify OR click on the Identify icon at the top of the screen; then click on the feature to identify; its attributes will also appear.

- *To access a layer’s attribute table*: The attribute tables cannot be accessed directly in ArcReader, except through the Identify feature. To access the complete table, open the layer’s accompanying .dbf file in any standard spreadsheet program.

- *To measure a distance*: Tools -> Data -> Measure OR click on the Measure icon at the top of the screen; then click once to begin the measurement and double-click to end the measurement.
• To view the layout view (for printing purposes): View -> Layout View OR click on the Layout view icon at the bottom of the screen. To return to the original view, click on Data View.

• To print a map: The map printed will be identical to the view in the Layout View. Create the appropriate view in the layout screen using the tools described above, then File -> Print OR the Print icon at the top of the screen.

• To save changes in a map: this is not a function allowed within ArcReader. Any changes made to the maps will not be saved, and the original map will be reloaded every time the map is opened.

**Accessing the included data**

The GIS data has been provided in three different formats: geodatabase, zipped shapefiles, and MapInfo files.

*Geodatabase files* (for users of ArcGIS AND for the ArcReader maps): The geodatabase is located under the transit agency’s named folder, then under the ArcGIS folder. It is a Microsoft Access file, named for the transit agency, which can also be utilized by the ArcGIS and ArcReader platforms. In the geodatabase, the files are stored in data sets for the line, point, and polygon features. All tabular data can be accessed in Access or any other standard spreadsheet software. To access the shapefiles directly requires ArcMap or ArcCatalog software.

NOTE: if any changes are made to the geodatabase, it will affect the functionality of the included ArcReader maps.

*Shapefiles* (for users of ArcView or any other compatible GIS platform): The shapefiles are located under the transit agency’s named folder, then under the ArcView folder. These files have been compressed into a zip file, named for the transit agency, and require the use of WinZip to extract them. The tabular data, in the form of .dbf files, can be accessed using any standard spreadsheet software. These files require the use of ArcView, a GIS platform that can utilize .shp files, or a platform that can transform the shapefiles into the necessary format utilized by that particular platform.

Ultimately, transit agencies will be receiving the following products from the project:

• One printable map of the system wide area, including the transit route system and the census block groups

• CD, including:
The data and maps developed for this project could form the base of further analysis to be performed for each transit agency. Examples could include, but not be limited to, additional maps of other existing census data values, more in-depth analysis of the census data already mapped, maps selective to individual routes and/or distances and/or buffers from the routes, bus stop inventories, TDP maps, and more.